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1 Introduction

This help document includes information on how to Quickly get Started in hsCADView as well as the
more in-depth details of the hsCADView Handbook. Also available are Licensing, Support, and Version
Information, as well as Frequently Asked Questions.

1.1 Quick Start

Quick Start provides an overview of hsCADView. It is a primary goal of Hachisoft Corporation that
hsCADView be a powerful tool in the hands of its user clientele. There are two fundamental ways to

use hsCADView. Click on a link below to learn more about the program.  

1. Printing Drawings
2. Viewing Drawings

To insure user success we recommend the following steps:

     1. Become acquainted with all of the tools--one may be more effective for your job undertaking
than another; knowing which tool to access and how to use it is critical to efficiently using the program.

     2. Use the program Help manual (or the hard copy Owners Manual). Questions you may have
can often be answered by carefully reading the pertinent information there. 

     3. Check the Frequently Asked Questions (FAQ) page. Your inquiry may already be covered there. 

     4. Contact us if steps (1), (2), or (3) have not alleviated your questions about how to use the
program. We would be glad to assist you. 

Note:
Evaluators of the free trial version of hsCADView may want to peruse the Evaluation Quick Start.

1.1.1 Open hsCADView

To open hsCADView click on hsCADView under your All Programs items. This will start the

hsCADView program.



Introduction 7

© 2006 Hachisoft Corporation

1.1.2 Evaluation (Trial Version)

If you have acquired a free trial copy of hsCADView, then it will start in an "Evaluation" mode. The
good news is that you now have everything you need to run a full version of hsCADView except a
license key. No additional downloads are necessary should you wish to purchase and continue using 
hsCADView past the evaluation period. 

For information on how to buy one or more licenses, please see the Upgrade Instructions.
For information on how to request trial extension, please see the Trial Extension Instructions.

When hsCADView starts in Evaluation mode, you will see this dialog:

  

Click the "Continue with hsCADView in Evaluation Mode" button to start hsCADView.

When the trial period expires the prompt will continue to allow you enter a license key, but will prevent

entrance to hsCADView. If more time is required to evaluate hsCADView, please see Trial
Extension for further information.

Return to the Quick Start.

Also See:
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Licensing

1.1.3 Viewing Drawings

hsCADView has variety of view tools available to easily inspect the drawing from different angles and
zoom levels. 

Also see:
View Tools

1.1.4 PrintingDrawings

hsCADView printing tools allow the user to print/plot existing drawings. Print Dialog allows user to
select paper size from more than 40 commercial paper sizes available, configure orientation and scale,
and import plot styles. 
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Also see:
View Tools

1.2 Terminology

Mouse-mode Terminology:

Left Click : Left-button of mouse pressed and released. (also referred to as click)

Right Click : Right-button of mouse pressed and released.

Middle Click/Wheel Click : Middle/Wheel button of mouse pressed and released.
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Wheel Scroll : Middle/Wheel button of mouse rotated.

Left Mouse Drag : Left-button of mouse pressed while moving mouse. 

Right Mouse Drag : Right-button of mouse pressed while moving mouse. 

Middle Mouse Drag: Middle-button of mouse pressed while moving mouse. 

Mouse Move : Without pressing any mouse button, move the mouse. 

Release Mouse : Release any button that is currently pressed on mouse.

Double Click : Use left click operation in quick succession.

Mathematical Terminology:

Perpendicular: Perpendicular is a geometric term that may be used as a noun or adjective. The
fundamental meaning pertains to the position of straight lines relative to one another. Two lines are
said to be perpendicular if they meet at a right angle. Note that two line segments positioned at 90° to
one another are perpendicular only if they meet.
  
Orthographic Projection: Orthographic projection is a means of representing a three-dimensional
object in two dimensions. It uses multiple views of the object, obtained by rotating camera about the
object's center through increments of 90°. It produces two plan views (top, bottom) and four side
views (front, back, left side, right side).

Isometric Projection:Isometric projection is a form of orthographic projection, or more specifically, an
axonometric projection. It is a method for the visual representation of three-dimensional objects in two
dimensions in which the angles between the projection of the x, y, and z axes are all the same, or
120°. Isometric projection can be visualized by considering the view of a cubical room from an upper
corner, looking towards the opposite lower corner. The term isometric comes from the Greek for
"equal measure.", which reflects that the scale along each axis of the projection is the same (this is not
true of some other forms of graphical projections). Isometric projection is one of the projections used
in drafting engineering drawings.

UCS: User Coordinate System/Space. The three-dimensional coordinate system where the drawing
screen is located (as compared to the World Coordinate System [WCS] which may or may not
coincide with the UCS).

WCS: World Coordinate System/Space. The three-dimensional coordinate system that is base for all
UCS. Each UCS-axis is define in WCS coordinates. In a drawing there is only one WCS but may have
one or more UCS.

2D space: 2D refers to the concept of a two-dimensional plane as in the Cartesian coordinate system
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with two axes, X and Y. Each axis is at right angles with the other axis. The point of intersection, where
the axes meet is called the origin and normally labeled 0 (or 0,0). To specify a particular point in a two-
dimensional coordinate system, the X unit (the horizontal distance from the origin, or abscissa), is
indicated first, followed by the Y unit (the vertical distance from the origin, or ordinate) is second. So for
example, the ordered pair (4,3) would represent that point four units to the right, and three units
above the origin. Likewise, the ordered pair (-4,-3) would represent that point four units to the left, and
three units below the origin. 

3D space: 3D refers to the concept of a three-dimensional coordinate system that includes the Z-axis
[altitude, or other third dimension of space measurement] in addition to the X-axis [horizontal] and Y-
axis [vertical] of the two-dimensional Cartesian coordinate system. Each axis is at right angles with the
other two. The point of intersection, where the axes meet is called the origin and normally labeled 0.
To specify a particular point in a three-dimensional coordinate system, the X unit (the horizontal
distance from the origin, or abscissa), is indicated first, followed by the Y unit (the vertical distance
from the origin, or ordinate) is second, and the Z unit (the applicate) is third.

1.3 Feature List

Full CAD Viewer functionality:

 View Drawings
 Print/Plot Drawings
 Export Drawings

Uses industry-standard file formats for viewing:

 DWG
 DXF
 DWF

Work with the assistance of Intuitive Tools:

 Tool Interaction Ü
 Point, click and drag mouse-based mode
 Context-sensitive tool properties allow for a precise data-entry mode (no cryptic "command

line" necessary)
 "Notify window" gives context-sensitive help, instructions, and feedback 
 Visual aids guide you through each tool process
 Unique cursors show you which tool you are using

 View Manipulation Tools Ü
 Pan
 Zoom to Window
 Zoom In
 Zoom Out
 Zoom Extent
 Rotate 
 Snap to standard orthogonal and isometric views
 Divide Viewport
 Standard Viewports
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 Rendering Tools Ü
 2D Wireframe 
 3D Wireframe 
 Hidden Lines 
 Flat Shaded
 Gouraud Shaded 
 Flat Shaded with edges
 Gouraud shaded with edges
 Regenerate

 Measure Tools Ü
 Measure Distance 
 Measure Area 
 Measure Angle 

2 Handbook

Designing and drafting with the aid of a computer is equal parts art and craft. hsCADView seeks to
facilitate the precision and practicality of CAD while still maintaining an enjoyable user experience. The
following handbook details aspects of the art and craft of CAD. 

 

 Concepts - Background information and introductive CAD theory.
 

 User Interface - The visual components of the hsCADView design interface, what they do, and
why. Describes all Tools, Toolbars, Menus, and Dialogs in detail.

  

 Files and Formats - Details on what file types, formats, and versions that are supported in this
application, as well as compatibility details.

2.1 Concepts

hsCADView employs specific concepts to facilitate drawing viewing:

Objects : Information holders for easy access to stored data.

Entity Snap
Settings 

: Ability to direct cursor to various points on an entity.

Grid : Display of equidistant points along X and Y axis for ease of drafting.

Drawing
Settings 

: Background color of drawing screen, Units, etc. settings for active drawing.

Data Types
and
Properties

: Various types of information commonly used in drawings.

Property
Trees

: Collection of properties displayed in tree structure.
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Tools : hsCADView provides a number of ways to easily create/edit/delete/manage all
entities, objects, and their properties. 

Toolbars : Collection of tools.

Dialogs : Collection of various user interfaces to get done various complex tasks easily.

Undo/Redo : Process to remove or reinstate last change made in drawing.

2.1.1 Objects

Objects are information holders in hsCADView. Objects allows easy access to stored non-
graphical data. There are total 4 type of objects in hsCADView.

1.

2.

3.

4.

Colors

 Layers

 Layouts

 Plot Settings 

2.1.1.1 Colors

Color Objects store color information in hsCADView. Color Objects are used to represent
colors of background, layer, line color, etc.  hsCADView creates nine colors on every
drawing: Red, Green, Yellow, Cyan, Blue, Magenta, Foreground, Dark Background and Light
Background.

2.1.1.2 Layers

Layer Objects can be described as invisible drawing sheets that can be activated to draw, turn
off/on to see entities on that layer, etc. 

2.1.1.3 Layouts

Layout Objects represents virtual drawing sheets. 

2.1.1.4 Plot Settings

Plot Settings Objects represents settings for printing drawings. 



hsCADView Help14

© 2006 Hachisoft Corporation

2.1.2 Snap Point Settings

Snap Settings define settings for Entity Snap Points and Grid Snap Points. These settings allow a
user to specify a precise point on any entity without any difficulty. 

1. Entity Snap Points
 

2. Grid Snap Points

2.1.2.1 Entity Snap Points

Entity Snap Points are key points on any entity that allows a user to select a precise point
without difficulty. 

There are two settings for Entity Snap Points :
Permanent Entity Snaps : This setting enables the Entity Snap Points till they are

explicitly turned OFF using "Enabled" property under Snap

Properties Tree. Or by the menu item "Enabled" found under the
View Menu >> Entity Snaps Submenu.

Temporary Entity Snaps : This setting enables the Entity Snap Points only for one
mouse click.  This type of snap is found by right-clicking and
bringing up the Temporary Snap Context menu

There are 12 different types of Entity Snap Points in hsCADView :

Name of Snap Point Description Example
End Point Snap to Entity end points

(Line, Polylines)

Mid Point Snap to Entity mid points
(Line, Polylines)

Center Point Snap to Entity center
points (Arc, Circle,
and Ellipse Entities)

Insertion Point Snap to insertion points
(Block Insert
Entities, Image Insert
Entities, Text)
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Intersection Point Snap to Intersection
(between any two
linear entities)

Nearest Point Snap to nearest point on
adjacent Entity 

Node Point Snap to Entity nodes
(Point Entity or
Dimension Entity
reference points)

Parallel Point Snap to end point on a
parallel line (When
creating a Line
Entity)

Perpendicular Snap to an end point on a
perpendicular line to
adjacent Entity (Line,
Polyline Entity)

Polar Point Snap to Polar coordinates
specified by Polar
Angle

Quadrant Point Snap to quadrant (Circle,
Arc, and Ellipse
Entities)

Tangent Point Snap to an end point on a
line tangent to
adjacent curve
Entity 

Polar Angle Incremental angle for
Polar Point snaps.

 
 

See also:
Snap Properties Tree
View Menu
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2.1.2.2 Grid Snap Points

Grid Snap Points allows easy access to snap the current cursor point to nearest grid point
available. This allows a user to easily jump from one point  another point on regular intervals
along UCS X and Y axis. A user can also keep the Grid invisible and still have access to  its
Grid Snap Points. The increments of Grid Snap Points can be changed by changing "Grid
Spacing along X-Axis" and "Grid Spacing along Y-Axis" variables in Modelspace Viewport.

2.1.3 Grid

The size of the grid sometimes is either too small or too large to display on the drawing screen. When
the user attempts to display the grid and a small grid window appears in the lower right hand

corner of the drawing screen with a red Æ symbol, the grid cannot currently be displayed. 

If the grid is too sparse the user must zoom out to display the grid; this grid window will show a widely
spaced grid like the following:

To zoom out, roll the top mouse wheel toward you, or find the Zoom Out Tool and select a point on
the drawing screen and Click.

Likewise, if the grid is too small the user must zoom in to display the grid; this grid window will show a
tightly spaced grid like the following:



Handbook 17

© 2006 Hachisoft Corporation

To zoom in, roll the top mouse wheel away from you, or find the Zoom In Tool and select a point on
the drawing screen. Click.

2.1.4 Drawing Settings

Drawing Settings define settings for overall drawing. These settings allow user access to
common properties for drawing.

In hsCADView, a Drawing Settings consists of the following data:

Field Name Data Type Description

Active Layout Multiple option combo box. Allows user to select from
available Layout list and make it
active.

Display Lineweight Boolean When checked(true) draws all
lines with actual lineweights
specified as lineweight
properties, otherwise it shows all
lines with default lineweight.

Background Color Color Background color for Layouts.

Save preview Boolean If checked(true) saves the
preview along with drawing file.
Saving preview allows user to
see snap shot of file before
actually opening it.

Units Multiple option combo box. Allows user to select from
available units and make it
default unit for this drawing. All
measurements are derived from
drawing's unit.
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Active Unit Family Multiple option combo box. Allows user to select from
available unit families and make
it active unit family for this
drawing. When using unit
conversion feature for all 
Scientific data, it uses active unit
family to show next conversion.

Filename File Name with full path Filename to save the current
drawing file.

Title Text Title name for this drawing

Subject Text Subject for this drawing

Comments Text Any comments or description for
this drawing

Author Text Name of author for this drawing

Revision Number Text Revision number for this drawing

Saved Via Text Name of application that last
saved this drawing

In hsCADView above properties are shown in Drawing Property Tree.

Click on image to see detail view.

2.1.5 Data Types and Properties

In hsCADView all entities and objects have different values(data) associated with it. These values
are also know as properties data or simply Properties. Properties data are of various types (Data

Types) as described below. hsCADView uses property trees (located to the right hand side of the
drawing screen) to edit individual Properties of entities, objects, and tools.  Each property has its own

visual depiction and ways of editing data depending on its Data Type. hsCADView has following
data types and properties associated with it:

Two-dimensional Point (2D Point):
Location of a point in an X-Y coordinate plane(2D space).
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Press Enter to update the information.
Press Escape to return the information to its previous value.
Press Tab to move to the next editable field.

 

Three-dimensional Point (3D Point):
Location of a point in an X-Y-Z coordinate space(3D space).

Press Enter to update the information.
Press Escape to return the information to its previous value.
Press Tab to move to the next editable field.

World Coordinate System Point (WCS Point):
Location of a point in the World (X-Y-Z) Coordinate Space.

Press Enter to update the information.
Press Escape to return the information to its previous value.
Press Tab to move to the next editable field.
Left click W icon that appears to the right to convert the point property from the WCS to the active
UCS.

 

User Coordinate System Point (UCS Point):
Location of a point in the User (X-Y-Z) Coordinate Space.

Press Enter to update the information.
Press Escape to return the information to its previous value.
Press Tab to move to the next editable field.
Left click U icon that appears to the right to convert the point property from the active UCS to
WCS.

Scientific Data:
A real number that has associated units (either metric or imperial) and can have minimum or
maximum values.  Scientific Data can also represent angles in either degrees or radians.

Left click unit text (mm) to convert the scientific data property from the current units to next unit in
the conversion set.

Vector:
An object defining direction and length of a ray. 

Press Enter to update the information.
Press Escape to return the information to its previous value.
Press Tab to move to the next editable field.

Boolean (On/Off):
Check box specifying True/False or On/Off or Yes/No Value.

Left click on the check box to change the value.



hsCADView Help20

© 2006 Hachisoft Corporation

Multiple option:

These properties are also known as drop-down list. They are accessed by left clicking on the
down arrow and then selecting required option from list using left click.

See also:

Tool Property Tree
Snap Property Tree
Drawing Property Tree
Viewport Property Tree

2.1.6 Property Trees

Property Tree is collection of properties arranged in a tree fashion. Each property in the property tree
has associated brief description. A property in a property tree is selected by left clicking on property
name. Whenever a property is selected, its brief description is shown at the bottom of the property tree
and the selected property name is highlighted. A property tree may have one or more sub-trees within
it. Each of these trees can be expanded/collapsed by double-clicking on the sub-tree name or the (+)
or (-) icon in front of the sub-tree name. 

Click on image to see detail view.

For more information on Property Trees used in hsCADView, please see chapter on hsCADView
Property Trees.

See also:
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hsCADView Property Trees

2.1.7 Tools

This application is built on the concept of tools. Loosely speaking, a tool for hsCADView is an
implementation with the ability to perform a certain class of operation or procedure with regards to
viewing and editing a drawing.

Tool Properties
Each tool may have a set of properties associated with it.

Active Tool
Only one tool may be active at a time. By choosing a tool with a toolbar, menu, or shortcut key, you are
making it the active tool. In the case of Stackable Tools, only the "top most" tool is active. The Tool
Properties
shows properties and options available for the active tool.  

2.1.8 Toolbars

Toolbar
Toolbar is a collection of Tools. Tool buttons are grouped by their functionality into tool "bars". Similar
tools are combined together in a toolbar for their easy placement and access. All of the toolbars have
the ability to dock/be placed on the various edges of the drawing window or place them anywhere on
drawing screen.  A toolbar can be moved by one of following methods depending on position of the
toolbar:

1. Left mouse dragging from its anchor line.

2. Left mouse dragging from its title bar.

When a toolbar is moved near the edge of the hsCADView screen area, its title bar is
removed and the toolbar tightly fits on the edge to save the screen space. Once you have
managed to position the toolbars and tool windows to fit your needs you can manage their
positions by using the following commands.

Preserve Layout (Saves the current placement and sizes of all user interface elements
within the workspace)
Restore Layout (Returns the current placement and sizes of all user interface elements
to the last Preserved Layout state)

Reset Layout (Sets the current layout to the hsCADView default)

These commands can be found by going to Window MenuÆLayoutÆPreserve Layout
command.  Visit Window Menu for more information on these menu items.
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Flyout Toolbar
Many toolbars have one or more than one toolbars hidden within them. These are known as Flyout
Toolbars. Flyout Toolbars are provided to save the screen space and allow easy access to different
Tool Modes. Flyout Toolbars are sub-toolbars hidden withinthe normal toolbars and are designated

by a small black arrow in the lower right hand corner of a toolbar icon  ( ).  By simply pointing at
the icon with the mouse cursor and right clicking, this hidden submenu will appear. The user may now
choose a tool from the sub toolbar by left clicking. When a user selects a tool from the Flyout toolbar
the selected tool will take the place of the tool in the parent menu.  

Activating Flyout Toolbar:   (right click)

            
Choosing New Tool to Activate:

Chosen Tool Replaces Old Tool in Parent Toolbar:

Following Flyout Toolbars are present in hsCADView:
               
View Toolbar:

Rotate View Tools (10 additional tool choices available)
                 

See also:
hsCADView Toolbars

2.1.9 Dialogs

Dialog is a collection of various user interface elements (tools, property trees, and properties). 
Dialogs provides easy access and management of more complex objects and entities. Dialogs also
provides easy way to do complex tasks. Most of dialogs when activated restricts access to the 

hsCADView main screen and other user interfaces outside the dialog. For more information on

dialogs used in hsCADView, please see chapter on hsCADView Dialogs.
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See also:
hsCADView Dialogs

2.1.10 Undo/Redo

To Undo a recently made change in drawing:
Using the keyboard

 : Press Ctrl+Z from the keyboard. Repeat as necessary to undo additional changes in
reverse order.

Using the Mouse: 

 : Go to the  Edit menu  and select ÄUndo

To Redo a recently undone change in drawing: 
Using the keyboard:

 : Press Ctrl +Y from the keyboard. Repeat as necessary to redo additional undone changes
in reverse order.

Using the mouse:

 : Go to the Edit menu and select ÄRedo
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2.2 User Interface

The User Interface of hsCADView is designed to be a simple, yet powerful tool for dealing
with daily tasks in computer aided drafting and design. The following types of user interfaces
are available in hsCADView.

 Menus

 Tools

 Toolbars

 Property Trees

 Dialogs

 Notify Window

 Status Bar 

 Visual Aids 

 Keyboard Shortcuts 

2.2.1 hsCADView Menus

There are eight main Menus available in hsCADView. They are located above the drawing screen in
the upper left hand corner of the monitor screen.

Main Menu:

1.   File Menu
 

2.   Edit Menu 
 

3.   View Menu
 

4.   Manage Menu
 

5.   Tools Menu 
 

6.   Options Menu
 

7.   Window Menu
 

8.   Help Menu

Context Menus:

In addition, there are also context menus available. Depending upon the tool in which the user is
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working, these are accessed by 8right clicking the mouse or pressing the 7Shift key on the

keyboard while 8right clicking the mouse.

1. View Options menu  (available to most tools) Access by 8right clicking the mouse with the cursor
in the drawing screen. Options available:

  
 Pan
 Rotate View
 Zoom

 Zoom In
 Zoom Out
 Zoom Extents
 Zoom Window

2. Temporary Snaps menu (available most tools) Access by holding 7Shift + 8right clicking with
the cursor in the drawing screen.  The Temporary Snaps act much like the Permanent Entity Snaps
except that they last for only one mouse click.  You can temporarily disable/enable the currently set 
Entity Snaps and or Grid Snaps.  You may also select one or more Entity Snaps you desire to use
temporarily.  This is useful for entity snapping that you do not commonly use but want to quickly switch
too.  Options available:

  
 Entity Snaps
 Grid Snaps
 End Point
 Mid Point
 Intersection
 Center Point
 Quadrant
 Insertion
 Nearest
 Node
 Perpendicular
 Polar
 Tangent
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 Parallel

 Set Permanent Snaps ( This will translate your Temporary Snap choices into your
permanent Entity Snaps.)

2.2.1.1 File Menu

 

The File Menu in hsCADView has the following options available:

1. New (Start a new drawing)
 
2. Open... (access a named drawing file previously saved)
 
3. Save (store a drawing  for future access)
 
4. Save As...(store a drawing under a different file name)
 
5. Export (save a copy of the drawing under a different file format)
 
6. Close (terminate the current drawing file)
 
7. Plot (print a drawing file)
 
8. Plot Preview (see beforehand how a drawing file will be printed)
 
9. Recent Files (displays files you have recently opened for quick access)
 
10. Exit (terminate all documents as well as the program)

(Note: Each option above is equipped with a keyboard shortcut to improve drawing efficiency; to
customize your shortcuts, see Key Accelerators under Options Menu)

2.2.1.2 Edit Menu
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The Edit Menu in hsCADView has the following options available:

1. Undo (take back the most recent change made within the drawing) 
 
2. Redo (restore a change that has been removed using the Undo command)
 

(Note: Each option above is equipped with a keyboard shortcut to improve drawing efficiency; to
customize your shortcuts, see Key Accelerators under Options Menu)

2.2.1.3 View Menu

The View Menu in hsCADView has the following options available:

1. Grid (Toggles the framework of evenly spaced/parallel vertical and horizontal lines used as a
drawing reference on/off)

 
2. Grid Snap (Toggles the grid snap ability on/off)
 
3. Entity Snaps (Sub-menu)

a. Enabled (Enable/Disable Permanent Entity Snaps)
b. End Point (Snap to an end point of a line segment)
c. Mid Point (Snap to mid point of a line segment)
d. Intersection (Snap to the intersection point)
e. Center Point (Snap to center of a circle, ellipse or arc)
f. Insertion (Snap to the Insertion point of blocks, images, or text)
g. Nearest (Snap to the nearest point on the entity to the cursor)
h. Node (Snaps to the point entity only)
i. Parallel (Snap parallel to nearest line to cursor)
j. Perpendicular (Snap to perpendicular point on line segment)
k. Polar (Snap to 0, 45deg, 90deg... etc)
l. Quadrant (Snap to the nearest quadrant on a circle, ellipse or arc)
m. Tangent (Snap to the point tangent to the circle, ellipse or arc)

 
4. Toolbar (Sub-menu)

a.  File Toolbar (Show/Hide this toolbar)
b.  View Toolbar (Show/Hide this toolbar)
c.  Render Toolbar (Show/Hide this toolbar)
d. Measure Toolbar (Show/Hide this toolbar)

5. Property Bar (Prop tree Tool Properties to the right of the drawing screen when a tool is
activated) 
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6. Status Bar (program information bar found at the bottom of drawing screen)
 
7. Regen (redraw all entities with updated information)

(Note: Each option above is equipped with a keyboard shortcut to improve drawing efficiency; to
customize your shortcuts, see Key Accelerators under Options Menu)

Also See:
Toolbars

2.2.1.4 Manage Menu

The Manage Menu in hsCADView has the following options available:
1. Quick Layers...(set color, line weight, line style, visibility, printed or not, etc.)

(Note: Each option above is equipped with a keyboard shortcut to improve drawing efficiency; to
customize your shortcuts, see Key Accelerators under Options Menu)

2.2.1.5 Tool Menu

The Manage Menu in hsCADView is a second way to access all the tools that are found on the View
, Measure, and Render Toolbars.

 View 
a. Rotate
b. Pan
c. Zoom
d. Snap
e. Divide Viewport

 Render
a. 2D Wireframe
b. 3D Wireframe
c. Hidden
e. Flat Shaded
f. Gouraud Shaded
g. Flat Shaded w/Edges
h. Gouraud Shaded w/Edges

 Measure
a. Measure Distance



Handbook 29

© 2006 Hachisoft Corporation

b. Measure Area
c. Measure Angle

(Note: Many of the above options and sub menus are equipped with a keyboard shortcut to improve
drawing efficiency; to customize your shortcuts, see Key Accelerators under Options Menu)

Also See:
Render Toolbar
Measure Toolbar

2.2.1.6 Options Menu

The Options Menu in hsCADView is generally where you go to alter the default settings as well as

manipulate the Keyboard shortcuts and manage hsCADView plugins.

1. Settings... (Location of the Application settings)
 
2. Key Accelerators... ( Set, Remove, Add, and Reset Keyboard Shortcuts for your favorite tools)
 

3. Manage Plugins... (Manage additions to the hsCADView application.)

2.2.1.7 Window Menu

The Window Menu in hsCADView is where you can manage multiple documents as well as
customize the Layout of the user interface.

1. Cascade (Places all open documents in an overlapping stair stepping fashion within the

hsCADView workspace)

2. Tile (Places all open documents in a visible rectangle within the hsCADView workspace without
any overlapping between documents)

3. Close All Windows (Will close all open documents within the hsCADView workspace. This will
not close the program.)

4. Layout
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a. Preserve Layout (Saves the current placement and sizes of all user interface elements
within the workspace)

b. Restore Layout (Returns the current placement and sizes of all user interface elements
to the last Preserved Layout state)

c. Reset Layout (Sets the current Layout to the hsCADView default)

5. Current Open Drawings (List of open drawings within the workspace.  Selection will activate that
document and make it the current working document.)

Also See:
Toolbars

2.2.1.8 Help Menu

The Help Menu in hsCADView provides an easy way to open the help documentation, manage the
license and discover the current program version you are working with.

1. About hsCADView... (Displays the About dialog that will display the program version number and
quick view at the license status.)

 

2. www.hachisoft.com  (This is a link to the designers of hsCADView. Check this site for update,
version upgrades and plugins.)

 
3. Purchase Upgrade to Full Version (This is a web link to the online store where you can

purchase one or more licenses of hsCADView.)
 
4. Activate License (Opens the License management dialog)
 
5. Help (Activates this help documentation)

2.2.2 hsCADView Tools

This application is built on the concept of tools. Loosely speaking, a tool for hsCADView is an
implementation of ability to perform a certain class of operation or procedure with regards to viewing
and editing a drawing. All tool gives different type of notifications in notification window as you advance
to different steps.

Tool Modes

 Select, click and drag mouse-based mode
 Context-sensitive tool properties allow for a precise data-entry mode

Tool Properties

http://www.hachisoft.com
http://products.hachisoft.com/Store/tabid/36/CategoryID/1/List/1/SortField/0/Level/1/ProductID/1/Default.aspx
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Each tool may have a set of properties associated with it. Tool properties can be changed to change
the tool's behavior.

hsCADView has always one active tool at any time. 

hsCADView has six different tool categories available to the user in addition to the standard file tools:

1.   View Tools : Tools used to alter viewing parameters (i.e. camera location, camera angle, camera
zoom level, etc.)

2.  Rendering Tools : Tools used to produce the different rendering view of the drawing.

3.  Measure Tools : Tools to measure lengths and area

2.2.2.1 View Tools

Following tools are available in hsCADView for manipulating the view of created entities within model
or paperspace:

1.  Zoom to Window Tool : Allows to draw a rectangle for zoom level

2.  Zoom In Tool : Allows entity (or region of entity) to be enlarged to fill the drawing screen

3.  Zoom Out Tool : Allows entity (or region of entity) to be shrunk to fill the drawing screen

4.  Zoom Extent Tool : Allows user to easily change view to cover full extents of drawing using
single click

 

5.  Pan View Tool : Allows entire drawing screen to be translated 

 

6.  Rotate View Tools : Tools Allowing entity movement about one or three axes 

 Rotate About Eye Vector Tool : Allows rotation of drawing screen about Z-axis (axis
coming to/going away from user)

 Rotate About Vertical Vector Tool : Allows rotation of drawing screen about Y-axis (up/
down axis)

 Rotate About Horizontal Vector Tool : Allows rotation of drawing screen about X-axis
(left/right axis)

 Rotate View 3D Tool : Allows simultaneous rotation of drawing screen about all three
axes (X,Y, and Z)        

 

7.  Preset View Snap Tools : Tools representing three-dimensional objects in two dimensions
(w/ two axes)

 Top View Tool : Tool representing overhead view of an object (traditional
representation)
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 Bottom View Tool : Tool representing underside of an object

 Front (South) View Tool : Tool representing front side of an object (traditional
representation)

 Back (North) View Tool : Tool representing back side of an object

 Left Side (West) View Tool : Tool representing left side of an object

 Right Side (East) View Tool : Tool representing the right side of an object (traditional
representation)

 Southwest View Tool : Tool representing front-left view of an object 

 Southeast View Tool : Tool representing front-right view of an object

 Northeast View Tool : Tool representing back-right view of an object

 Northwest View Tool : Tool representing back-left view of an object

 

8.  Divide Viewport Tool : Allows user to divide active Modelspace viewport vertically or
horizontally.

 

9.  Pre-configured Viewport Tools : Various (10) screen division formats to accommodate
simultaneous multiple viewing

 Single Viewport

 Two Vertical Viewports

 Two Horizontal Viewports

 Three - Right Viewports

 Three - Left Viewports

 Three - Bottom Viewports

 Three - Top Viewports

 Four Even Viewports

 Four - Right Viewports

 Four - Left Viewports

2.2.2.1.1  Zoom Tools

Following Zoom Tools are available to change zoom level of current view in hsCADView:

 Zoom to Window Tool : Allows to draw a rectangle for zoom level
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 Zoom In Tool : Allows entity (or region of entity) to be enlarged to fill the drawing screen

 Zoom Out Tool : Allows entity (or region of entity) to be shrunk to fill the drawing screen

 Zoom Extent Tool : Allows user to easily change view to cover full extents of drawing using single
click

 

2.2.2.1.1.1  Zoom to Window Tool

 View Toolbar : 

The Zoom to Window Tool allows for a user to designate a rectangle and the view will zoom to that
user specified window.

Using the Zoom to Window Tool:

Activate the Zoom to Window Tool:

Find one of the Zoom to Window Tool icon  from the View Toolbar (color coded red)
and highlight it. While highlighted Click on the tool.  The tool is now the active tool and
ready for use.

 Use the Mouse to Zoom to Window:
1. Click and hold the left mouse button to start drawing the Zoom rectangle.
2. Move the mouse while still holding the left button down.  This will display a

temporary zoom rectangle.  Release the left button when the rectangle is positioned
as desired. The drawing will now update with the proper zoom for the designated
rectangle to fit within the view screen.

Reset:
You have just zoomed to a custom zoom window.  The Tool has now Reset and you can
choose a different tool or select another Zoom Window.

Tool Options:

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).  

 Space: key Resets this tool.

Also See: 
View Toolbar

2.2.2.1.1.2  Zoom In Tool

 View Toolbar : 
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In hsCADView the Zoom In Tool is used to enlarge the drawing screen.  

Using the Zoom in Tool:

Activate the Zoom in Tool:

Find one of the Zoom in Tool icon  from the View Toolbar (color coded red) and
highlight it. While highlighted Click on the tool.  The tool is now the active tool and ready
for use.

Note: This tool can be utilized via the middle mouse scroll wheel without activating this
tool and without interrupting other tool processes.  This usage is noted below.

 Use the Mouse to Zoom In:
1. Click on a point within the drawing screen to zoom to that location.  This point of

focus will be placed at the center of the screen for easier viewing.

Reset:
You have just zoomed in.  The Tool has now Reset and you can choose a different tool

or select another point to Zoom In on.
Note: Zooming in or Zooming out too far may cause the loss of sight of the drawing grid.

See the topic Grid for more information.

 Use the Mouse Scroll Wheel to Zoom In:
1. Use the mouse Scroll Wheel to zoom in.  Move the scroll wheel in a counter-

clockwise motion. The mouse must contain a middle mouse scroll wheel to utilize
this feature.

No Reset:
Using the Scroll Wheel to zoom does not Reset the tool.  You can utilize other tools and
within a tool process you may zoom in, zoom out and pan using the mouse without
interrupting that tool's procedure.
Note: Zooming in or Zooming out too far may cause the loss of sight of the drawing grid.
See the topic Grid for more information.

Tool Options:

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).

 Space: key Resets this tool.

Also See: 
View Toolbar

2.2.2.1.1.3  Zoom Out Tool

 View Toolbar : 
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In hsCADView the Zoom Out Tool is used to shrink the view size within the drawing screen.

Using the Zoom Out Tool:

Activate the Zoom Out Tool:

Find the Zoom Out Tool icon  from the View Toolbar (color coded red) and highlight
it. While highlighted Click on the tool.  The tool is now the active tool and ready for use.

Note: This tool can be utilized via the middle mouse scroll wheel without activating this
tool and without interrupting other tool processes.  This usage is noted below.

 Use the Mouse to Zoom Out:
1. Click on a point within the drawing screen to zoom out from that location.  This point

of focus will be placed at the center of the screen for easier viewing.

Reset:
You have just zoomed out.  The Tool has now Reset and you can choose a different tool
or select another point to Zoom Out from.
Note: Zooming in or Zooming out too far may cause the loss of sight of the drawing grid.

See the topic Grid for more information.

 Use the Mouse Scroll Wheel to Zoom Out:
1. Use the mouse Scroll Wheel to zoom out.  Move the scroll wheel in a clockwise

motion. The mouse must contain a middle mouse scroll wheel to utilize this feature.

No Reset:
Using the Scroll Wheel to zoom does not Reset the tool.  You can utilize other tools and
within a tool process you may zoom in, zoom out and pan using the mouse without
interrupting that tool's procedure.
Note: Zooming in or Zooming out too far may cause the loss of sight of the drawing grid.
See the topic Grid for more information.

Tool Options:

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).

 Space: key Resets this tool.

Also See: 
View Toolbar

2.2.2.1.1.4  Zoom Extent Tool

 View Toolbar : 
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In hsCADView the Zoom To Extents is used zoom in or out such that the entire drawing is visible
within the drawing screen.

Using the Zoom To Extents Tool:

Using the Zoom to Extents Tool:

Find the Zoom To Extents Tool icon  from the View Toolbar (color coded red) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display all of the drawing such that it will fit to the limits of the drawing screen.

Note: This tool will not Activate.  It is a one time tool.  This means you can use this tool at
any time and without interrupting other tool processes.

Also See: 
View Toolbar

2.2.2.1.2  Pan View Tool

 View Toolbar : 

In hsCADView the Pan View Tool is used to translate the entire drawing within the drawing screen.  

Using the Pan View Tool:

Activate the Pan View Tool:

Find one of the Pan View Tool icon  from the View Toolbar (color coded red) and
highlight it. While highlighted Click on the tool.  The tool is now the active tool and ready
for use.

Note: This tool can be utilized via the middle mouse button click without activating this
tool and without the interruption other tool processes.  This usage is noted below.

 Use the Mouse to Pan the View:
1. Click and hold the left mouse button on a point within the drawing screen.  While

holding the button down move the mouse and translate the entire drawing within the
drawing screen to the desired location.

Reset:
You have just performed a Pan of the View.  The Tool has now Reset and you can

choose a different tool or perform another Pan View.
Note: It is possible to pan the drawing to where you can no longer see any of the drawing
on the screen.  If you cannot find the drawing use the Zoom to Extents to reset the view
on the drawing.

 Use the Middle Mouse Button to Pan the View:
1. Click and hold the middle mouse button.  While holding the button down move the

mouse and translate the entire drawing within the drawing screen to the desired
location. Note: you must have a middle mouse button to utilize this feature.

No Reset:
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Using the Middle Mouse button to Pan the View does not Reset the tool.  You can utilize
other tools and within a tool process you may zoom in, zoom out and pan using the
mouse without interrupting that tool's procedure.
Note: It is possible to pan the drawing to where you can no longer see any of the drawing
on the screen.  If you cannot find the drawing use the Zoom to Extents to reset the view
on the drawing.

Tool Options:

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).

 Space: key Resets this tool.

Also See: 
View Toolbar

2.2.2.1.3  Rotate View Tools

 View Toolbar : 

In hsCADView, entities can be rotated around each axis in a 2D or 3D plane separately, or all three
simultaneously. The following tools facilitate viewing from different perspectives:

Using the Rotate View Tools:

Activate a Rotate View Tool:

Find one of the Rotate View Tool icons  from the View Toolbar(color
coded red) and highlight it. While highlighted Click on the tool.  The tool is now the active
tool and ready for use.

Rotating the View:
There are four different tools that will allow rotation of the view.

Rotate About Eye Vector Tool : The eye vector is that which approaches (or goes away
from) the user's eye. This tool rotates entities about an axis in a circular motion (similar to
a pinwheel twirling on a wall).

Rotate About Vertical Vector Tool : This tool rotates entities around an up and down
axis (similar to a tetherball circling an upright pole).

Rotate About Horizontal Vector Tool : This tool rotates entities around a side to side
axis (similar to a gymnast rotating about a high bar).

Rotate View 3D Tool : This tool rotates entities about all three axes simultaneously (like
a skydiver rolling and tumbling in a free fall--any rotational movement is possible).
 

Also See: 
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View Toolbar

2.2.2.1.3.1  Rotate About Eye Vector Tool

 View Toolbar : 

In hsCADView, the Rotate About Eye Vector Tool facilitates rotational movement about an axis
coming to and going away from the eye of the user. (Note: depending upon the arbitrary assignment of
axes this axis can either be X,Y, or Z or some other user designated vector.)

Using the Rotate About Eye Vector Tool:

Activate the Rotate About Eye Vector Tool:

Find the Rotate About Eye Vector icon  from the View Toolbar (color coded red)
and highlight it. While highlighted Click on the tool.  The tool is now the active tool and
ready for use.

 Use the Mouse to Rotate the View about the Eye Vector:
1. Click and hold the left mouse button down.  While holding the left button down move

the mouse around the center of the drawing screen.  As you move the mouse you
will see the drawing rotate about the vector created from the center of the screen to
the eye of the user or Eye Vector. Release the left mouse button when the rotation is
as desired.  

Reset:
You have just Rotated about the Eye Vector.  The Tool has now Reset and you can

choose a different tool or rotate about the Eye Vector
again.

Note: It may be helpful to watch the UCS icon in the bottom left corner of the drawing
screen as you rotate the entity. Any axis that is moving toward you is represented with a
solid line while an axis moving away is dotted.

Tool Options:
Horizontal vector mode changes the active tool to Rotate about Horizontal Vector Tool.  
Up vector mode changes the active tool to Rotate about Vertical Vector Tool  
Eye vector mode is the mode where the view is Rotated about Eye Vector  
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Set target mode changes the active tool to Rotate about 3D Tool.  
Target point depicts the point about which the rotation will occur.  

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).  

 Space: key Resets this tool.

Also See: 
View Toolbar
UCS Axis Display
Eye Vector

2.2.2.1.3.2  Rotate About Vertical Vector Tool

 View Toolbar : 

In hsCADView, the Rotate About Vertical Vector Tool facilitates rotational movement around an
up/down axis or vertical vector. (Note: depending upon the arbitrary assignment of axes this axis can
either be X,Y, Z, or some other user defined vector.)

Using the Rotate About Vertical Vector Tool:

Activate the Rotate About Vertical Vector Tool:

Find the Rotate About Vertical Vector icon  from the View Toolbar (color coded red)
and highlight it. While highlighted Click on the tool.  The tool is now the active tool and
ready for use.

 Use the Mouse to Rotate the View about the Vertical Vector:
1. Click and hold the left mouse button down.  While holding the left button down move

the mouse from right to left for a clockwise rotation about the vertical vector or left to
right for counter-clockwise rotation about the vertical vector.  As you move the
mouse you will see the drawing rotate about the vertical vector.  Release the left
mouse button when the rotation is as desired.  

Reset:
You have just Rotated about the Vertical Vector.  The Tool has now Reset and you can

choose a different tool or rotate about the vertical
vector again.

Note: It may be helpful to watch the UCS icon in the bottom left corner of the drawing
screen as you rotate the entity. Any axis that is moving toward you is represented with a
solid line while an axis moving away is dotted.
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Tool Options:
Horizontal vector mode changes the active tool to Rotate about Horizontal Vector Tool.  
Up vector mode is the current mode for rotating the view about the vertical vector.  
Eye vector mode changes the active tool to Rotate about Eye Vector Tool.
Set target mode changes the active tool to Rotate about 3D Tool.  
Target point depicts the point about which the rotation will occur.  

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).

 Space: key Resets this tool.

Also See: 
View Toolbar
UCS Axis Display 
Vertical Vector

2.2.2.1.3.3  Rotate About Horizontal Vector Tool

 View Toolbar : 

In hsCADView, the Rotate About Horizontal Vector Tool facilitates the rotational movement of an
object about a side to side axis or Horizontal Vector. (Note: depending upon the arbitrary assignment
of axes this axis can either be X,Y, or Z.)

Using the Rotate About Horizontal Vector Tool:

Activate the Rotate About Horizontal Vector Tool:

Find the Rotate About Horizontal Vector icon  from the View Toolbar (color coded
red) and highlight it. While highlighted Click on the tool.  The tool is now the active tool
and ready for use.

 Use the Mouse to Rotate the View about the Horizontal Vector:
1. Click and hold the left mouse button down.  While holding the left button down move

the mouse from top to bottom or bottom to top for rotation about the Horizontal
Vector.  As you move the mouse you will see the drawing rotate about the Horizontal
Vector.  Release the left mouse button when the rotation is as desired.  

Reset:
You have just Rotated about the Horizontal Vector.  The Tool has now Reset and you
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can choose a different tool or rotate about the 
Horizontal Vector again.

Note: It may be helpful to watch the UCS icon in the bottom left corner of the drawing
screen as you rotate the entity. Any axis that is moving toward you is represented with a
solid line while an axis moving away is dotted.

Tool Options:
Horizontal vector mode is the current mode for rotating the view about the Horizontal Vector
.   
Up vector mode changes the active tool to Rotate about Vertical Vector Tool.
Eye vector mode changes the active tool to Rotate about Eye Vector Tool.
Set target mode changes the active tool to Rotate about 3D Tool.  
Target point depicts the point about which the rotation will occur.  

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).

 Space: key Resets this tool.

Also See: 
View Toolbar
UCS Axis Display 
Horizontal Vector

2.2.2.1.3.4  Rotate View 3D Tool

 View Toolbar : 

In hsCADView, the Rotate View 3D Tool facilitates the simultaneous rotational movement of an
entity about all three axes with the origin at a user defined Target. (Note: depending upon the arbitrary
assignment of axes a particular axis can be X,Y, or Z.)

Using the Rotate 3D Tool:

Activate the Rotate 3D Tool:

Find the Rotate 3D Tool icon  from the View Toolbar (color coded red) and highlight
it. While highlighted Click on the tool.  The tool is now the active tool and ready for use.

 Use the Mouse to Rotate the View in 3D about the Target:
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1. Click and hold the left mouse button down.  While holding the left button down move
the mouse in any direction.  As you move the mouse you will see the drawing rotate
about the Target.  Release the left mouse button when the rotation is as desired.  

Reset:
You have just Rotated about the Target Point.  The Tool has now Reset and you can

choose a different tool or rotate about the Target
Point again.

Note: It may be helpful to watch the UCS icon in the bottom left corner of the drawing
screen as you rotate the entity. Any axis that is moving toward you is represented with a
solid line while an axis moving away is dotted.
Note: It may be necessary to reset the rotation.  

Tool Options:
Horizontal vector mode changes the active tool to Rotate about Horizontal Vector Tool.  
Up vector mode changes the active tool to Rotate about Vertical Vector Tool.
Eye vector mode changes the active tool to Rotate about Eye Vector Tool.
Set target mode is the current mode for rotating the view about the Target in 3D.
Target point depicts the point about which the rotation will occur.  

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).

 Space: key Resets this tool.

Also See: 
View Toolbar
UCS Axis Display 

2.2.2.1.4  Preset View Snap Tools

 View Toolbar : 

In hsCADView, Viewing the drawing in the best manner possible as well as snapping to common
views within 3D space make working in this drawing environment much easier.  The View Snap Tools
provide a quick view manipulation toolbox for this very reason.

Using the Preset View Snap Tools:
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Activate a Preset View Snap Tool:

Find one of the Preset View Snap Tool icons  from
the View Toolbar (color coded red) and highlight it. While highlighted Click on the tool.
The tool is now the active tool and ready for use.  This set of tools is part of a Flyout
toolbar.  To learn how to change tool selection on a flyout toolbar see Flyout Toolbar.

Use a Preset View Tool:
There are six different Orthographic View Tools to use for quick view manipulation

Top View Tool
 

Bottom View Tool
 

Front (South) View Tool
 

Back (North) View Tool
 

Left Side (West) View Tool
 

Right Side (East) View Tool
 

There are four different Isometric View Tools to use for quick view manipulation.

Southwest View Tool
 

Southeast View Tool
 

Northeast View Tool
 

Northwest View Tool

Also See: 
View Toolbar
Flyout Toolbar

2.2.2.1.4.1  Top View Tool

 View Toolbar : 

In hsCADView the Orthographic Projection Top View Tool facilitates viewing of an object from
above. This traditional plan view used in architecture and building engineering can be thought of as a
diagram of a room, a building, or a level (floor) of a building as if seen from a "bird's eye" view. 

Using the Top View Tool:

Using the Top View Tool:

Find the Top View Tool icon  from the View Toolbar (color coded red) and highlight
it. While highlighted Click on the tool.  The drawing screen will now refresh and will
display all of the drawing such that it is looking down in a "bird's eye" view of the 3D
drawing.

Note: This tool will not Activate.  It is a one time tool.  This means you can use this tool at
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any time and without interrupting other tool processes.
Note: This tools is part of a Flyout toolbar.  To learn how to change tool selection on a
flyout toolbar see Flyout Toolbar.

Also See: 
View Toolbar
Flyout toolbar

2.2.2.1.4.2  Bottom View Tool

 View Toolbar : 

In hsCADView the Orthographic Projection Bottom View Tool facilitates viewing of an object from
underneath. This nontraditional plan view is used primarily in instances where additional object detail
(to a top view) is necessary. 

Using the Bottom View Tool:

Using the Bottom View Tool:

Find the Bottom View Tool icon  from the View Toolbar (color coded red) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display all of the drawing such that it is looking up at the underside of 3D drawing.

Note: This tool will not Activate.  It is a one time tool.  This means you can use this tool at
any time and without interrupting other tool processes.

Note: This tools is part of a Flyout toolbar.  To learn how to change tool selection on a
flyout toolbar see Flyout Toolbar.

Also See: 
View Toolbar
Flyout toolbar

2.2.2.1.4.3  Front (South) View Tool

 View Toolbar : 

In hsCADView the Orthographic Projection Front (South) View Tool facilitates viewing of an object
from its front side. This traditional orthographic view is used in architecture and building engineering
and is the most critical elevation (i.e the above-ground-level front view of a building)  

Using the Front (South) View Tool:

Using the Front (South) View Tool:

Find the Front (South) View Tool icon  from the View Toolbar (color coded red) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display all of the drawing such that it is looking at the front side of a 3D drawing.

Note: This tool will not Activate.  It is a one time tool.  This means you can use this tool at
any time and without interrupting other tool processes.

Note: This tools is part of a Flyout toolbar.  To learn how to change tool selection on a
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flyout toolbar see Flyout Toolbar.

Also See: 
View Toolbar
Flyout toolbar

2.2.2.1.4.4  Back (North) View Tool

 View Toolbar : 

In hsCADView the Orthographic Projection Back (North) View Tool facilitates viewing of an object
from behind. This traditional elevation (i.e. above ground level rear view of a building) used in
architecture and building engineering is second only to the front elevation. 

Using the Back (North) View Tool:

Using the Back (North) View Tool:

Find the Back (North) View Tool icon  from the View Toolbar (color coded red) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display all of the drawing such that it is looking at the back side of a 3D drawing.

Note: This tool will not Activate.  It is a one time tool.  This means you can use this tool at
any time and without interrupting other tool processes.

Note: This tools is part of a Flyout toolbar.  To learn how to change tool selection on a
flyout toolbar see Flyout Toolbar.

Also See: 
View Toolbar
Flyout toolbar

2.2.2.1.4.5  Left Side (West) View Tool

 View Toolbar : 

In hsCADView the Orthographic Projection Left Side (West) View Tool facilitates viewing of an
object from its left side. This nontraditional orthographic view, however, is important in architecture and
building engineering (i.e the above-ground-level left side view of a building) 

Using the Left Side (West) View Tool:

Using the Left Side (West) View Tool:

Find the Left Side (West) View Tool icon  from the View Toolbar (color coded red)
and highlight it. While highlighted Click on the tool.  The drawing screen will now refresh
and will display all of the drawing such that it is looking at the Left or West side of a 3D
drawing.

Note: This tool will not Activate.  It is a one time tool.  This means you can use this tool at
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any time and without interrupting other tool processes.
Note: This tools is part of a Flyout toolbar.  To learn how to change tool selection on a
flyout toolbar see Flyout Toolbar.

Also See: 
View Toolbar
Flyout toolbar

2.2.2.1.4.6  Right Side (East) View Tool

 View Toolbar : 

In hsCADView the Orthographic Projection Right Side (East) View Tool facilitates viewing of an
object from its right side. This traditional orthographic view is also used in architecture and building
engineering (i.e the above-ground-level right side view of a building) 

Using the Right Side (East) View Tool:

Using the Right Side (East) View Tool:

Find the Right Side (East) View Tool icon  from the View Toolbar (color coded red)
and highlight it. While highlighted Click on the tool.  The drawing screen will now refresh
and will display all of the drawing such that it is looking at the Right or East side of a 3D
drawing.

Note: This tool will not Activate.  It is a one time tool.  This means you can use this tool at
any time and without interrupting other tool processes.

Note: This tools is part of a Flyout toolbar.  To learn how to change tool selection on a
flyout toolbar see Flyout Toolbar.

Also See: 
View Toolbar
Flyout toolbar

2.2.2.1.4.7  Southwest View Tool

 View Toolbar : 

In hsCADView the Isometric Projection Southwest View Tool facilitates viewing an object from
above, as well as from the front (south) and left (west) sides. Note: After a front view is arbitrarily
assigned, four different isometric projections can be viewed as the object is rotated clockwise.

Using the Southwest View Tool:
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Using the Southwest View Tool:

Find the Southwest View Tool icon  from the View Toolbar (color coded red) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display all of the drawing such that it is looking down at the Front Left or South
West corner of a 3D drawing.

Note: This tool will not Activate.  It is a one time tool.  This means you can use this tool at
any time and without interrupting other tool processes.

Note: This tools is part of a Flyout toolbar.  To learn how to change tool selection on a
flyout toolbar see Flyout Toolbar.

Also See: 
View Toolbar
Flyout toolbar

2.2.2.1.4.8  Southeast View Tool

 View Toolbar : 

In hsCADView the Isometric Projection Southeast View Tool facilitates viewing an object from
above, as well as from the front (south) and right (east) sides. Note: After a front view is arbitrarily
assigned, four different isometric projections can be viewed as the object is rotated clockwise.

Using the Southeast View Tool:

Using the Southeast View Tool:

Find the Southeast View Tool icon  from the View Toolbar (color coded red) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display all of the drawing such that it is looking down at the Front Right or South
East corner of a 3D drawing.

Note: This tool will not Activate.  It is a one time tool.  This means you can use this tool at
any time and without interrupting other tool processes.

Note: This tools is part of a Flyout toolbar.  To learn how to change tool selection on a
flyout toolbar see Flyout Toolbar.

Also See: 
View Toolbar
Flyout toolbar

2.2.2.1.4.9  Northeast View Tool

 View Toolbar : 

In hsCADView the Isometric Projection Northeast View Tool facilitates viewing an object from
above, as well as from the back (north) and right (east) sides. Note: After a front view is arbitrarily
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assigned, four different isometric projections can be viewed as the object is rotated clockwise.

Using the Northeast View Tool:

Using the Northeast View Tool:

Find the Northeast View Tool icon  from the View Toolbar (color coded red) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display all of the drawing such that it is looking down at the Back Right or North
East corner of a 3D drawing.

Note: This tool will not Activate.  It is a one time tool.  This means you can use this tool at
any time and without interrupting other tool processes.

Note: This tools is part of a Flyout toolbar.  To learn how to change tool selection on a
flyout toolbar see Flyout Toolbar.

Also See: 
View Toolbar
Flyout toolbar

2.2.2.1.4.10  Northwest View Tool

 View Toolbar : 

In hsCADView the Isometric Projection Northwest View Tool facilitates viewing an object from
above, as well as from the back (north) and left (west) sides. Note: After a front view is arbitrarily
assigned, four different isometric projections can be viewed as the object is rotated clockwise.

Using the Northwest View Tool:

Using the Northwest View Tool:

Find the Northwest View Tool icon  from the View Toolbar (color coded red) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display all of the drawing such that it is looking down at the Back Left or North West
corner of a 3D drawing.

Note: This tool will not Activate.  It is a one time tool.  This means you can use this tool at
any time and without interrupting other tool processes.

Note: This tools is part of a Flyout toolbar.  To learn how to change tool selection on a
flyout toolbar see Flyout Toolbar.

Also See: 
View Toolbar
Flyout toolbar

2.2.2.1.5  Divide Viewport Tool

 View Toolbar : 
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In hsCADView the Divide Viewport Tool will custom divide the drawing screen into multiple
viewports allowing you to create you own personal workspace with the views you need.

Using the Viewport Divide Tool:

Activate the Viewport Divide Tool:

Find the Viewport Divide Tool icon  from the View Toolbar (color coded red) and
highlight it. While highlighted Click on the tool.  The tool is now the active tool and ready
for use.

 Use the Mouse Divide the Active Viewport:
1. Move the mouse around and you will see a temporary cutting edge.  When this

cutting edge is positioned as desired Click to divide the viewport at that location.
The tool will divide the active viewport either horizontally or vertically based on the 
Split Type found in the Viewport Divide Settings.
Note: The Viewport Divide tool will only divide the Active Viewport. To divide a
different viewport you will need to select it before using this tool.

Reset:
You have just divided this viewport.  The Tool has now Reset and you can choose a
different tool or divide the active viewport.

 Divide the Active Viewport using the Property Tree:      

To divide the viewport with more precise data do the following.  Move the mouse cursor
beyond the right side of the drawing screen to the Tool Property Tree.  

1. Select the Split Type from the "Split Type" Drop down Combo.  The two choices
are Vertical and Horizontal.

2. Type in the Percentage data into the "Percentage" Scalar Data Field found on the 
Tool Property Tree and press Enter to accept.  In Horizontal Mode 0% is at the
bottom of the viewport and 100% is the top of the viewport.  If in Vertical Mode 0%
is located at the left and 100% is located at the right of the viewport. 

Reset:
You have just divided this viewport.  The Tool has now Reset and you can choose a
different tool or divide the active viewport.
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Tool Options:
Split Type is the type of cut the divide tool will make.  The choices are Vertical or Horizontal.
Percentage allows the user to specify splitting percentage of the active viewport.

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).

 Space: key Resets this tool.

Also See: 
View Toolbar
Pre-Configured Viewport Tools

2.2.2.1.6  Pre-configured Viewport Tools

 View Toolbar : 

In hsCADView there are ten Pre-configured Viewport Tools from which to choose. Each offers a
different drawing screen format to aid the user in viewing multiple projections of an entity
simultaneously. The following descriptions will aid you in choosing the best format for your drawing
project:

Using the Viewport Divide Tool:

Activate a Pre-Configured Viewport Tool:

Find one of the Pre-Configured Viewport Tool icons 

 from the View Toolbar (color coded red) and highlight it. While highlighted Click on
the tool.  The tool has now changed the viewport settings for your drawing.  

Note: These tools will not Activate.  They are one time tools.  This means you can use
this tool at any time and without interrupting other tool processes to change the way you
work within the drawing screen.

 
There are ten different Pre-Configured ways to display the drawing screen broken into
one or more viewports. 

1.  Single Viewport Tool : Drawing screen remains whole. Find the Single
Viewport Tool icon <insert image> from the View Toolbar (color coded red) and
maneuver the mouse to it. The cursor will highlight the icon and a small box around
it. Right click. Ten pre-configured viewport tools will appear in a flyout toolbar. The
Single Viewport Tool  is the first (default). Click. The drawing screen viewport will
remain whole.  
     

2.  2 Vertical Viewports Tool : The drawing screen will be divided into two equal
viewports with a vertical divider. Select the second tool from the flyout toolbar.
Click. 
     

3.  2 Horizontal Viewports Tool : The drawing screen will be divided into two
equal viewports with a horizontal divider. Select the third tool from the flyout           
                                                         toolbar. Click. 
     



Handbook 51

© 2006 Hachisoft Corporation

4.  3 Right Viewports Tool : The drawing screen will be divided into two equal
viewports vertically. The portion on the left will be further divided horizontally into
two viewports (for a total of three). Select the fourth tool from the flyout toolbar.
Click. 
     

5.  3 Left Viewports Tool : The drawing screen will be divided into two equal
viewports vertically. The portion on the right will be further divided horizontally into
two viewports (for a total of three). Select the fifth tool from the flyout toolbar. Click.
     

6.  3 Bottom Viewports Tool : The drawing screen will be divided into two equal
viewports horizontally. The upper portion will be further divided vertically into two
viewports (for a total of three). Select the sixth tool from the flyout toolbar. Click.

7.  3 Top Viewports Tool : The drawing screen will be divided into two equal
viewports horizontally. The lower portion will be further divided vertically into two
viewports (for a total of three). Select the seventh tool from the flyout toolbar. Click.
    

8.  4 Even Viewports Tool : The drawing screen will be divided into four equal
viewports (horizontally and vertically). Select the eighth tool from the flyout              
                    toolbar. Click.
   

9.  4 Right Viewports Tool : The drawing screen will be divided into two equal
viewports vertically. The portion on the left will be further divided horizontally into
three equal viewports (for a total of four). Select the ninth tool from the flyout
toolbar. Click.

10.  4 Left Viewports Tool : The drawing screen will be divided into two equal
viewports vertically. The portion on the right will be further divided horizontally into
three equal viewports (for a total of four). Select the tenth (or last tool) from the
flyout toolbar. Click. 

Also See: 
View Toolbar
Divide Viewport Tool

2.2.2.2 Rendering Tools

In hsCADView, Eight Rendering Tools are available to the user to render drawings in different
ways:

1.   2D Wireframe Tool
 

2.   3D Wireframe Tool
 

3.   Hidden Tool
 

4.   Flat Shaded Tool
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5.   Gouraud Shaded Tool
 

6.   Flat Shaded With Edges Tool
 

7.   Gouraud Shaded With Edges Tool
 

8.   Regenerate Tool

    
   

2.2.2.2.1  2D Wireframe Tool

 Rendering Toolbar : 

Using the 2D Wireframe Tool:

Using the 2D Wireframe Tool:

Find the 2D Wireframe Tool icon  from the Rendering Toolbar (color coded teal) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display 2D wireframe model for all solid entities.

Note: This tool will not Activate.  It is a one click tool and when finished it will activate
select tool.

Also See: 
Rendering Toolbar

2.2.2.2.2  3D Wireframe Tool

 Rendering Toolbar : 

Using the 3D Wireframe Tool:

Using the 3D Wireframe Tool:

Find the 3D Wireframe Tool icon  from the Rendering Toolbar (color coded teal) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display 3D wireframe model for all solid entities.

Note: This tool will not Activate.  It is a one click tool and when finished it will activate
select tool. 

Also See: 
Rendering Toolbar

2.2.2.2.3  Hidden Tool

 Rendering Toolbar : 



Handbook 53

© 2006 Hachisoft Corporation

Using the Hidden Tool:

Using the Hidden Tool:

Find the Hidden Tool icon  from the Rendering Toolbar (color coded teal) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display model such that all lines that are behind any solid face are hidden from view.
Note: This tool will not Activate.  It is a one click tool and when finished it will activate

select tool. 

Also See: 
Rendering Toolbar

2.2.2.2.4  Flat ShadedTool

In hsCADView the Flat Shaded Tool alters the 3D rendering mode. Flat shading is lighting
technique used in 3D computer graphics. It shades each polygon of an object based on the angle
between the polygon's surface normal and the direction of the light source, their respective colors and
the intensity of the light source. It is usually used for high speed rendering where more advanced
shading techniques are too computationally expensive.

The disadvantage of flat shading is that it gives low-polygon models a faceted look. Sometimes this
look can be advantageous though, such as in modeling boxy objects. Artists sometimes use flat
shading to look at the polygons of a solid model they are creating. More advanced and realistic lighting
and shading techniques include Gouraud shading and Phong shading.

This tool incorporates the flat shading technique but without visible object edge lines.

 Rendering Toolbar : 

Using the Flat Shaded Tool:

Using the Flat Shaded Tool:

Find the Flat Shaded Tool icon  from the Rendering Toolbar (color coded teal) and
highlight it. While highlighted Click on the tool.  The drawing screen will now refresh and
will display modelspace entities with Flat Shaded mode.
Note: This tool will not Activate.  It is a one click tool and when finished it will activate

select tool. 

Also See: 
Rendering Toolbar

2.2.2.2.5  Gouraud ShadedTool

In hsCADView the Gouraud Shaded Tool alters the 3D rendering mode.  Gouraud shading is a
method used in computer graphics to simulate the differing effects of light and color across the surface
of an object. In practice, Gouraud shading is used to achieve smooth lighting on low-polygon surfaces
without the heavy computational requirements of calculating lighting for each pixel.

This tool incorporates the Gouraud shading technique but without visible object edge lines.

 Rendering Toolbar : 
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Using the Gouraud Shaded Tool:

Using the Gouraud Shaded Tool:

Find the Gouraud Shaded Tool icon  from the Rendering Toolbar (color coded teal)
and highlight it. While highlighted Click on the tool.  The drawing screen will now refresh
and will display modelspace entities with Gouraud Shaded mode.
Note: This tool will not Activate.  It is a one click tool and when finished it will activate

select tool. 

Also See: 
Rendering Toolbar

2.2.2.2.6  Flat Shaded With EdgesTool

In hsCADView the Flat Shaded With Edges Tool alters the 3D rendering mode. Flat shading is
lighting technique used in 3D computer graphics. It shades each polygon of an object based on the
angle between the polygon's surface normal and the direction of the light source, their respective
colors and the intensity of the light source. It is usually used for high speed rendering where more
advanced shading techniques are too computationally expensive.

The disadvantage of flat shading is that it gives low-polygon models a faceted look. Sometimes this
look can be advantageous though, such as in modeling boxy objects. Artists sometimes use flat
shading to look at the polygons of a solid model they are creating. More advanced and realistic lighting
and shading techniques include Gouraud shading and Phong shading.

This tool incorporates the flat shading technique with visible object edge lines.

 Rendering Toolbar : 

Using the Flat Shaded With Edges Tool:

Using the Flat Shaded With Edges Tool:

Find the Flat Shaded With Edges Tool icon  from the Rendering Toolbar (color
coded teal) and highlight it. While highlighted Click on the tool.  The drawing screen will
now refresh and will display modelspace entities with Flat Shaded With Edges mode.
Note: This tool will not Activate.  It is a one click tool and when finished it will activate

select tool. 

Also See: 
Rendering Toolbar

2.2.2.2.7  Gouraud Shaded With EdgesTool

In hsCADView the Gouraud Shaded With Edges Tool alters the 3D rendering mode. Gouraud
shading is a method used in computer graphics to simulate the differing effects of light and color
across the surface of an object. In practice, Gouraud shading is used to achieve smooth lighting on
low-polygon surfaces without the heavy computational requirements of calculating lighting for each
pixel.

This tool incorporates the Gouraud shading technique with visible object edge lines.

 Rendering Toolbar : 
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Using the Gouraud Shaded With Edges Tool:

Using the Gouraud Shaded With Edges Tool:

Find the Gouraud Shaded With Edges Tool icon  from the Rendering Toolbar (color
coded teal) and highlight it. While highlighted Click on the tool.  The drawing screen will
now refresh and will display modelspace entities with Gouraud Shaded With Edges
mode.
Note: This tool will not Activate.  It is a one click tool and when finished it will activate

select tool. 

Also See: 
Rendering Toolbar

2.2.2.2.8  Regenerate Tool

In hsCADView the Regenerate Tool initiates a refreshment of the drawing in progress.

 Rendering Toolbar : 

Using the Regenerate Tool:

Using the Regenerate Tool:

Find the Regenerate Tool icon  from the Rendering Toolbar (color coded teal) and
highlight it. While highlighted Click on the tool.  The drawing screen will now redraw all
the entities visible on the screen.
Note: This tool will not Activate.  It is a one click tool and when finished it will activate

select tool.

Also See: 
Rendering Toolbar

2.2.2.3 Measure Tools

In hsCADView, Measure Tools allow easy measurement of length and area. There are two different
tools for measuring length and area.

1.  Measure Distance Tool  

2.  Measure Area Tool

3.  Measure Angle Tool

2.2.2.3.1  Measure Distance Tool

 Measure Toolbar : 

In hsCADView the Measure Distance Tool facilitates measurement of length along polyline or arc.
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Measuring Lengths:
Activate the Measure Distance Tool:

Find the Measure Distance Tool icon  from the Measure Toolbar (color coded lavender)
and highlight it. While highlighted Click on the tool.  The tool is now the active tool and ready
for use.  

                             

 Measure Distance using Mouse:    
1. Move the mouse and Click anywhere on the screen. This will be the Start Point

from which the current length will be measured.
2. Move the mouse and Click anywhere on the screen. This will be the Tape Point to

which the current length will be set. And current length will be added to Total
Length. 

3. Successively select next Tape Points to keep on adding length to Total Length.
4. Alternatively, to change Start Point of tape in-between adding Total Length, use

SHIFT+ENTER shortcut.
5. To measure length along an arc, change Measure Mode in Tool Property Tree to "

Measure along arc" and select Start Point, Point on Arc, and Tape Point.

Reset:
You have just finished measuring lengths.  The tool has now Reset and you can either
continue with other tools or measure other lengths again.

 Measure Distance using Property Tree:    

To Measure Distance in a more precise manner do the following.  Move the mouse
cursor beyond the right side of the drawing screen to the Tool Property Tree.  

1. Type in the Start Point point data into the "Start Point" 3D Point Property Field
found on the Tool Property Tree and press Enter to accept.

2. Type in the Tape Point point data into the "Tape Point" 3D Point Property Field
found on the Tool Property Tree and press Enter to accept. The tool measures
current length from Start Point to Tape Point and adds it to Total Length. 

3. Successively, type in the Tape Point point data into the "Tape Point" 3D Point
Property Field found on the Tool Property Tree and press Enter to accept to keep on
adding length to Total Length.

4. Alternatively, to change Start Point of tape in-between adding Total Length, use
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SHIFT+ENTER shortcut.
5. To measure length along an arc, change Measure Mode in Tool Property Tree to "

Measure along arc" and type in Start Point, press Enter, type Point on Arc, press
Enter, type Tape Point, and press Enter.

Reset:
You have just finished measuring lengths.  The tool has now Reset and you can either
continue with other tools or measure other lengths again.

 Measure Distance Options Menu :    
Options Menu for Measure Distance Tool can be accessed by right click on drawing
screen while Measure Distance Tool is active.

Tool Options:
Continuous Measure keeps on adding the current length to Total length.
Auto Snap turns on common entity snaps for easy selection of points on entities.
Measure along polyline mode allows measuring length along polylines.
Measure along arc mode allows measuring length along circular arcs.
Change Start Point allows user to change current start point of tape.

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).

 Space: key Resets this tool.

Also See:
Entity Snaps
Measure Area Tool
Notification Bar

2.2.2.3.2  Measure Area Tool

 Measure Toolbar : 

In hsCADView the Measure Area Tool facilitates measurement of area of polygons.

Measuring Areas:
Activate the Measure Area Tool:

Find the Measure Area Tool icon  from the Measure Toolbar (color coded lavender) and
highlight it. While highlighted Click on the tool.  The tool is now the active tool and ready for
use.  

                             

 Measure Area using Mouse:    
1. Move the mouse and Click anywhere on the screen. This will be the first vertex for

polygon, from which the current area will be measured.
2. Move the mouse and Click anywhere on the screen. This will be the second vertex

for polygon. 
3. Successively select next vertext points to measure Current Area.
4. Alternatively, use SHIFT+ENTER to start new polygon. This will add Current Area to
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Total Area and reset Current Area to zero to measure new polygon area.

Reset:
You have just finished measuring area.  The tool has now Reset and you can either
continue with other tools or measure other polygon area again.

 Measure Area using Property Tree:    

To Measure Area in a more precise manner do the following.  Move the mouse cursor
beyond the right side of the drawing screen to the Tool Property Tree.  

1. Type in the Current Point point data into the "Current Point" 3D Point Property
Field found on the Tool Property Tree and press Enter to accept.

2. Successively, type in the Current Point point data into the "Current Point" 3D Point
Property Field found on the Tool Property Tree and press Enter to accept to keep on
adding area to Current Area.

4. Alternatively, use SHIFT+ENTER to start new polygon. This will add Current Area to
Total Area and reset Current Area to zero to measure new polygon area.

5. To measure area along an arc, change Measure Mode in Tool Property Tree to "
Measure along arc" and type in Start Point, press Enter, type Point on Arc, press
Enter, type Tape Point, and press Enter.

Reset:
You have just finished measuring area.  The tool has now Reset and you can either
continue with other tools or measure other polygon area again.

 Measure Area Options Menu :    
Options Menu for Measure Area Tool can be accessed by right click on drawing screen
while Measure Area Tool is active.

NOTE: Measure Area tool can not calculate area of self intersecting polygons or non-planar polygons.
In order to calculate these, use "Continuous Mode" and dis-integrate self-intersecting/non-planar
polygons into simple polygons.
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Tool Options:
Continuous Measure keeps on adding the current area to Total area.
Auto Snap turns on common entity snaps for easy selection of points on entities.
Measure along polyline mode allows measuring area along polylines.
Measure along arc mode allows measuring area along circular arcs.
Change Start Point allows user to start a new polygon to measure area.

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).

 Space: key Resets this tool.

Also See:
Entity Snaps
Measure Distance Tool
Notification Bar

2.2.2.3.3  Measure Angle Tool

 Measure Toolbar : 

In hsCADView the Measure Angle Tool facilitates measurement of angles.

Measuring Areas:
Activate the Measure Angle Tool:

Find the Measure Angle Tool icon  from the Measure Toolbar (color coded lavender) and
highlight it. While highlighted Click on the tool.  The tool is now the active tool and ready for
use.  

                             

 Measure Angle using Mouse:    
1. Move the mouse and Click anywhere on the screen. This will be the start point for

the angle being measured.
2. Move the mouse and Click anywhere on the screen. This will be the center point for

the angle being measured. 
3. Move the mouse and Click anywhere on the screen. This will be the end point for the

angle being measured. 

Reset:
You have just finished measuring angle.  The tool has now Reset and you can either
continue with other tools or measure angles again.

 Measure Angle using Property Tree:    

To Measure Angle in a more precise manner do the following.  Move the mouse cursor
beyond the right side of the drawing screen to the Tool Property Tree.  
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1. Type in the Start Point point data into the "Start Point" 3D Point Property Field
found on the Tool Property Tree and press Enter to accept.

2. Type in the Center Point point data into the "Center Point" 3D Point Property Field
found on the Tool Property Tree and press Enter to accept.

3. Type in the End Point point data into the "End Point" 3D Point Property Field found
on the Tool Property Tree and press Enter to accept.

Reset:
You have just finished measuring angles.  The tool has now Reset and you can either
continue with other tools or measure angles again.

 Measure Angle Options Menu :    
Options Menu for Measure Area Tool can be accessed by right click on drawing screen
while Measure Area Tool is active.

Tool Options:
Continuous Measure keeps on adding the current area to Total area.
Auto Snap turns on common entity snaps for easy selection of points on entities.

 Escape (Esc): key cancels current tool and activates the default tool (Pan Tool).

 Space: key Resets this tool.

Also See:
Entity Snaps
Measure Distance Tool
Notification Bar

2.2.3 hsCADView Toolbars

hsCADView makes its Tools available primarily through the use of Toolbars and Menus. Each tool
has a representational icon and a tool button. By pressing the tool button, you activate that tool.
Toolbar Visibility:
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hsCADView has the ability to show/hide each of toolbars and tool windows.  To show/hide a

toolbar/tool window open the View MenuÆToolbar and select the name of the toolbar to
show/hide.  

Toolbars:
File Toolbar :

View Toolbar :

Rendering Toolbar :  

Measure Toolbar :

Also See:
Menus
Toolbars

2.2.3.1 View Toolbar

Description:
The tools associated with the View Toolbar are used to alter the 2D or 3D view of the drawing. 

   
 
1. 2. 3. 4. 5. 6. 7. 8. 9. 10. 11. 12.

1. Zoom To Window Tool  
 

2. Zoom In Tool 
 

3. Zoom Out Tool
 

4. Zoom Extent Tool
 

5. Pan View Tool 
 

6. Rotate About Eye Vector Tool
 

7. Rotate About Vertical Vector Tool 
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8. Rotate About Horizontal Vector Tool                
 

9. Rotate View 3D Tool  
 

10. View Snap Tools has a Flyout Toolbar

      
a. b. c. d. e. f. g. h. i. j.

a. Top View Tool
b. Bottom View Tool
c. Front (South) View Tool
d. Back (North) View Tool
e. Left Side (West) View Tool
f. Right Side (East) View Tool
g. Southwest View Tool
h. Southeast View Tool
i. Northeast View Tool
j. Northwest View Tool

11. Divide Viewport (Splits the current viewport into two parts either horizontally or vertically based
on the tool setting)

 

12. Viewport Presets has a Flyout Toolbar

a. b. c. d. e. f. g. h. i. j.
a. Single Viewport Tool
b. 2 Vertical Viewports Tool
c. 2 Horizontal Viewports Tool
d. 3 Right Viewports Tool
e. 3 Left Viewports Tool
f. 3 Bottom Viewports Tool
g. 3 Top Viewports Tool
h. 4 Even Viewports Tool
i. 4 Right Viewports Tool
j. 4 Left Viewports Tool

     

Also See:
Tool Menu
Flyout Toolbar

2.2.3.2 Rendering Toolbar

Description:
The tools associated with the Rendering Toolbar are used to alter the rendering of the drawing. 

 
1. 2. 3. 4. 5. 6. 7. 8.

1. 2D Wireframe Tool (Default Render mode)
 

2. 3D Wireframe Tool 
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3. Hidden Tool 
 

4. Flat shaded Tool 
 

5. Gouraud Shaded Tool 
 

6. Flat Shaded With Edges Tool
 

7. Gouraud Shaded With Edges Tool
 

8. Regenerate Tool (Refreshes all entities and rendering within a drawing.)

Also See:
Tool Menu

2.2.3.3 File Toolbar

Description:
The tools associated with the File Toolbar are used to for the basic document operations of open,
save, print, and help. 

 
1. 2. 3. 4. 5. 6.

1. New (Create a new document)
 

2. Save (Save the active document)
 

3. Open (Open an existing named document)
 

4. Print/Plot (Print/Plot the active document)
 

5. Print/Plot Preview (Preview how the active document will print)
 

6. Help (Opens the help documentation)

Also See:
File Menu
File Formats
Print/Plot

2.2.3.4 Measure Toolbar

Description:
The tools associated with the Measure Toolbar are used to for the basic document operations of
open, save, print, and help. 

 
1. 2. 3.

1. Measure Distance : Measure Distance along lines and arc.
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2. Measure Area :  Measure area of polygons.
 

3. Measure Angle : Measure angles
 

Also See:
Tool Menu

2.2.4 hsCADView Property Trees

hsCADView uses property trees to edit individual properties. Following property trees are accessible

in hsCADView :

 Tool Property Tree

 Snap Property Tree

 Drawing Property Tree

 Viewport Property Tree

2.2.4.1 Tool Property Tree
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2.2.4.2 Snap Property Tree

2.2.4.3 Drawing Property Tree

Click on image to see detail view.
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2.2.4.4 Viewport Property Tree

2.2.5 hsCADView Dialogs

Following dialogs are used in hsCADView:

 About Dialog

 Application Settings Dialog

 Print Dialog

2.2.5.1 About hsCADView Dialog

The About Dialog displays information about hsCADView and the current status of the License.

 Current Version Number for hsCADView

 Licensee Name:  Name of License Owner or Company License Contact

 Licensee Company: Name of Company 

 Licensee Email  Email of License Owner or Company Contact

 Licensee Phone Number : Phone number of License Owner or Company Contact

 License Site Code : Generated

 Machine Code : Generated

 License Group Code : Code from online purchase or media case.

 Activation Code : Generated
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2.2.5.2 Application Settings Dialog

Application Settings are program level settings. These settings are not saved with drawing, but

saved with hsCADView program. Whenever a new drawing or an existing drawing is opened
previously set Application Settings are applied to it. Application Settings are accessible through
Application Settings Dialog. To access this dialog use Options->Settings... Menu item.

Field Name Data Type Description
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Use Auto Save Boolean Enable/disable auto save feature

Auto Save Interval Integer Number Time interval between each auto
save in minutes.

Auto Save Directory Folder Path Path to folder for temporary auto
save files.

Drawings Directory Folder Path Path to current drawing's
directory.

Raster Directory Folder Path Path to current drawing's raster
files.

Plot Style Directory Folder Path Path to current drawing's plot
style directory.

Tesselation Deviation Real Number Value that controls the resolution
for drawing non-linear curves.
Lower the value, higher is
resolution. 

Region Selection UCS Tolerance Real Number Tolerance for selecting region
that is on UCS plane.

Region Selection Point
Tolerance

Real Number Tolerance for selecting point that
is on UCS plane.

Decimal Places Integer Number Number of decimal places to
display for all numbers used in
drawing.

Default Drawing Units Multi-option selection box Default drawing units to be used
for newly created drawings.

Active Unit Family Multi-option selection box Currently active unit family

Notification: Show Tool Options Boolean Enable/disable tool options
notifications.

Notification: Show Tool
Activations

Boolean Enable/disable tool activations
notifications.

Trim Trailing Zeros Boolean Enable/disable trimming of
trailing zeros.

Default Viewer Settings:
Permanent Entity Snap Settings Entity Snap Settings Default entity snap settings to be

used for newly created drawings.

Default Drawing Settings Drawing Settings Default drawing settings to be
used for newly created drawings.

2.2.5.3 Print Dialog

 Print dialog gives access to print/plot settings. This dialog is accessible from File->Print/Plot menu
item. 
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2.2.5.4 Quick Layer Dialog

 Quick Layer dialog gives access to edit layer properties. This dialog is accessible from Manage-
>Quick Layer menu item. 
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To turn ON/OFF any layer:
Click on the "light-bulb" icon infront of the layer name. Depending on drawing's size, it

may take longer to reflect changes in drawing.
To FREEZE/THAW any layer:

Click on the "Sun/Snow" icon infront of the layer name. Depending on drawing's size, it
may take longer to reflect changes in drawing.

To Lock/Unlock any layer:
Click on the "Lock" icon infront of the layer name. Depending on drawing's size, it may

take longer to reflect changes in drawing.
To include/exclude a layer in printing:

Click on the "Printer" icon infront of the layer name. Depending on drawing's size, it may
take longer to reflect changes in drawing.

To edit any other properties, click on "Manage Layers..." button to access detailed layer
properties dialog.

2.2.6 Notify Window

The Notify Window tracks and displays a variety of information regarding the current state of the
design process. Messages are displayed in order of arrival, with the latest message first. Messages
have one of 6 color-coded types.

Type Format Purpose
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Option OPTION:ACTION Displays information on how to
activate special options in the
currently active tool. OPTION is
the name of the choice, and
ACTION is the key or mouse
action used to activate the
choice. These messages can be
turned on or off in the Settings
Dialog.

Instruction [INSTRUCTION] When a tool is expecting user
input, it uses these messages to
explain precisely what action is
necessary in order to continue.

Action ENTITY=(0,1,2) When a tool completes an
action of interest, it relates this
information back to the user.

Activate / Deactivate Tool Name Activated
Tool Name Deactivated

These messages occur when a
tool is activated or deactivated.
These also show when 
Stackable Tools are being used.
These messages can be turned
on or off in the Settings Dialog.

Warning Warning! "I" before "E" EXCEPT
after "C".

A tool uses these messages to
notify the user that input and
actions may not have the
desired result, or if there exists
a potential for error.

Error ERROR! "Ain't" ain't a word. This mechanism notifies the
user when a problem has
occurred in the system, either
through incorrect input or an
internal error.

2.2.7 Status Bar

 

 Status Bar is located at the bottom of hsCADView's window. It shows the current status of the

hsCADView. It also shows brief description of a tool when user moves over mouse on any tool.
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2.2.8 Visual Aids

Beside the usual visual feedback of the mouse cursor, different tools will employ visual aids
to enhance the use of that tool. Different tools will use different visual aids as appropriate. 

Preview Entities
Entity Creation tools incorporate a preview entity and one or more entity design widgets. The
preview entity shows what an entity would look like if you were to complete the current
process with the current choices. Thus, a line preview entity would show you what the line
would look like if you were to click it. The preview entities are shown with dotted lines.

Cursor Icons
There are various cursor icons to give user a visual feedback of currently active tool. The cursor icon
changes whenever active tool is changed. Apart from active tool cursor icons, there is also invalid input

cursor icon . Whenever the input under cursor becomes invalid the cursor icon changes to invalid

input cursor . 

Cursor Targets
This is a very common visual aid. There are two types of cursor target representation. 

 Round cursor target ( )

 Square cursor target ( )

Round target cursor( ) is shown whenever user moves the mouse around before
selecting any point. Square target cursor ( ) is drawn whenever user selects some point
during any tool step. In example below drawing arc with arc tool start and middle points
are already selected and are shown with square target . The end point is still not selected
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and hence is shown as round target  :

 

2.2.9 Keyboard Shortcuts

hsCADView is installed with color coded shortcuts from keyboard for very easy access to various
frequently used tools.These default shortcut keys can be changed by  from  
Command Key Mapping Dialog.

Command Key Mapping dialog can be opened from Options->Key Accelerators... menu item. In the
following picture, each default shortcut key is shown with its toolbars color. 

In hsCADView, default shortcut keys are as follows:

Shortcut Key Function
F1 Opens Help for hsCADView

View Toolbar :

Shortcut Key Function
W Zoom to Window Tool
NUMPAD + Zoom In Tool
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NUMPAD - Zoom Out Tool
F Pan View Tool
NUMPAD 5 Top View Tool
NUMPAD 0 Bottom View Tool
NUMPAD 8 Front (South) View Tool
NUMPAD 2 Back (North) View Tool
NUMPAD 4 Left Side (West) View Tool
NUMPAD 6 Right Side (East) View Tool
NUMPAD 1 Southwest View Tool
NUMPAD 3 Southeast View Tool
NUMPAD 7 Northwest View Tool
NUMPAD 9 Northeast View Tool

Rendering Toolbar :  

Shortcut Key Function
F6 2D Wireframe Tool
F7 3D Wireframe Tool
F8 Hidden Tool
F9 Flat Shaded Tool
F10 Gouraud Shaded Tool
F11 Flat Shaded with Edges Tool
F12 Gouraud Shaded with Edges Tool

2.3 Export

hsCADView can export opened drawing file to following formats.           
 

 DWG

 DWF : Multi Layout

 DWF : Single Layout

 DXB

 DXF

 Email Attachment

 Image

 PDF

 SVG

2.3.1 DWG Format

DWG(Drawing) format is standard format for most of the CAD(Computer Aided Drafting) drawing
files. 

hsCADView supports DWG formats for open/edit/create drawings.

Following release formats of DWG are supported:
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DWG Release 9
DWG Release 10
DWG Release 12
DWG Release 13
DWG Release 14
DWG Release 15
DWG Release 18
DWG Release 21

Exporter Dialog can be used to export existing drawing to any of above format.
Exporter Dialog is accessed from File Menu :: Exporter... menu option.

Pressing Export... button creates new DWG file with given File Name.

2.3.2 DXF Format

DXF is a Drawing Interchange Format.

hsCADView supports DXF formats for open/edit/create drawings.

Following release formats of DXF are supported:
DXF Release 9
DXF Release 10
DXF Release 12
DXF Release 13
DXF Release 14
DXF Release 15
DXF Release 18
DXF Release 21

Exporter Dialog can be used to export existing drawing to any of above format.

Exporter Dialog is accessed from File Menu :: Exporter... menu option.
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Pressing Export... button creates new DXF file with given File Name.

2.3.3 DWF : Multi Layout Format

DWF is a Drawing Web Format. This format is commonly used to upload drawings on website for
easy viewing and access.

hsCADView supports DWF: Multi Layout formats for open/edit/create drawings.

Following release formats of DWF : Multi Layout are supported:
Binary DWF v6.0
Zipped ASCII  Encoded 2D Stream DWF v6.0

Exporter Dialog can be used to export existing drawing to any of above format.

Exporter Dialog is accessed from File Menu :: Exporter... menu option.
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Pressing Export... button creates new DWF file with given File Name.

2.3.4 DWF : Single Layout Format

DWF is a Drawing Web Format. This format is commonly used to upload drawings on website for
easy viewing and access.

hsCADView supports DWF : Single Layout formats for open/edit/create drawings.

Following release formats of DWF : Single Layout are supported:
3-D DWF v6.01
Binary DWF v6.0
Zipped ASCII  Encoded 2D Stream DWF v6.0
Compressed Binary DWF v5.5
Uncompressed Binary DWF v5.5
ASCII DWF v5.5
Compressed Binary DWF v4.2
Uncompressed Binary DWF v4.2
ASCII DWF v4.2

Exporter Dialog can be used to export existing drawing to any of above format.

Exporter Dialog is accessed from File Menu :: Exporter... menu option.



hsCADView Help78

© 2006 Hachisoft Corporation

Pressing Export... button creates new DWF file with given File Name.

2.3.5 DXB Format

DXB is a Drawing Interchange Binary Format. 

hsCADView can convert any opened drawing to DXB format:

Following release formats of DXB are supported:
DXB Release 9
DXB Release 10
DXB Release 12
DXB Release 13
DXB Release 14
DXB Release 15
DXB Release 18
DXB Release 21

Exporter Dialog can be used to export existing drawing to any of above format.

Exporter Dialog is accessed from File Menu :: Exporter... menu option.
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Pressing Export... button creates new DXB file with given File Name.

2.3.6 Email Attachment

hsCADView can be used to attach current drawing in an email easily with Exporter Dialog. 

Exporter Dialog is accessed from File Menu :: Exporter... menu option.

Pressing Export... button opens a new email to compose with current drawing already attached with
email.
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2.3.7 Image Format

Currently hsCADView supports BMP (Bitmap) Image format. Using Exporter Dialog, hsCADView
can convert current drawing to BMP format.

Exporter Dialog is accessed from File Menu :: Exporter... menu option.

Pressing Export... button creates new BMP image file with given File Name.

2.3.8 PDF Format

PDF is a Portable Document Format. 

hsCADView can convert any opened drawing to PDF format using Exporter Dialog.

Exporter Dialog is accessed from File Menu :: Exporter... menu option.
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Pressing Export... button creates new PDF file with given File Name. 
If there is any plot style(stylesheet) associated with exported layout, it gets applied to pdf document.

2.3.9 SVG Format

SVG is a Scalable Vector Graphics format. 

hsCADView can convert any opened drawing to SVG format using Exporter Dialog.

Exporter Dialog is accessed from File Menu :: Exporter... menu option.
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Pressing Export... button creates new SVG file with given File Name.

2.4 Supported Files and Formats

hsCADView can open a variety of files and formats and convert between variety of formats.

Input Formats that can be opened/viewed/edited by hsCADView are :
 

DWG 
DXF
DWF : Multi Layout
DWF : Single Layout

Output Formats can be created/converted to from opened drawing in hsCADView are :              
 

DWG
DWF : Multi Layout
DWF : Single Layout
DXB
DXF
Email Attachment
Image
PDF
SVG

3 Licensing

 This software is controlled by a licensing system. A license key is a unique identifier used to activate
your copy of the software for use under the End-User License Agreement.

 This software requires a valid license key and running this software causes a License Key Entry

Dialog to appear until one is entered. By default, hsCADView is installed with an Evaluation license
key which allows use for a trial period.

 Full version licenses may be purchased by opening the "Help" menu and clicking on the "Purchase
Upgrade to Full Version" menu item, or by visiting hsCADView website.

This software is controlled by a seat enforcing licensing system.  The evaluation version of 
hsCADView allows a user a trial period of 5 days and/or 5 uses.  After the evaluation term has
expired the software is locked and cannot be used without an activation code.  Hachisoft Corporation
sells its software as license groups.  A license group can contain one or more license seats.   You may
purchase a license group by visiting (http blah).

3.1 Licensing Application

Licensing hsCADView:

1. Press the "Buy Full Version hsCADView" or use hsCADView website to buy Full Version
License Key.

2. Press the "Enter Full Version License Key" or use the Help->Activate License Menu to

http://products.hachisoft.com/Purchase/tabid/75/List/1/CategoryID/2/Level/a/Default.aspx?SortField=ProductNumber%2cProductNumber
http://products.hachisoft.com/Purchase/tabid/75/CategoryID/2/List/1/Level/a/Default.aspx?SortField=ProductNumber,ProductNumber
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activate hsCADView.

  

or

   

3. The Manage hsCADView Licensing dialog will popup and will allow you to enter the "
License Group Code" you purchased. 
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4. Press the "Activate" button to activate your copy of hsCADView.
 

Also See:
Managing License Groups
About Dialog (License Interface)
End-User License Agreement
Trial Extensions

3.2 Managing License Groups

Managing License Groups:
Hachisoft Corporation sells its software as license groups.  A license group can contain one or

more license seats.  On activation the licensing system ties a seat of hsCADView to a given
computer.  The licensing system supports adding more seats to a license group, activating seats,

removing seats and transferring seats of hsCADView from machine to machine. 

The hsCADView setup can be passed command line parameters that allow remote administration
for volume and site license management.  These parameters are:

/VERYSILENT  -- runs the installation without showing any of the GUI configurations and forms.
/hsKEY -- uses the passed parameter as the license group code for each installation of
hsCADView.  On initialization, hsCADView will attempt to automatically activate a seat from the
license group pool.  This simplifies deployment of hsCADView across large groups of users.

Also See:
Activating License Seats
Removing License Seats
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3.2.1 Activating a Seat

Web Activation:

Enter the "License Group Code" you received in your confirmation email (online purchases) or
the "License Group Code" on the cd case (media purchases), a unique "Seat Name" and press "
Activate".    Hachisoft Corporation will automatically check the validity of the "License Group

Code" and generate an "Activation Code" that will unlock hsCADView.  Press "Done" to use

hsCADView… licensing is now complete.

 

Phone Activation:

Call Hachisoft Corporation at 1 877 685 0760.  Tell the operator the "License Group Code" you
received in your confirmation email (online purchases) or the "License Group Code" on the cd
case (media purchases), the "Site Code", "Machine Code", and a unique "Seat Name".  The
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operator will check the validity of the "License Group Code" and generate an "Activation Code"

that will unlock hsCADView.  Enter the "Activation Code" that they told you and press "Activate

". Press "Done" to use hsCADView… licensing is now complete.

3.2.2 Remove a Seat

 

Web Removal:

Press "Remove" to remove this license from current machine and restore into the "License
Group" pool.  Please note that the application will close on successful removal and you will be

required to activate a seat to use hsCADView on this computer.   A dialog will ask you if you

really want to remove the seat.  Press "Yes" to remove this seat of hsCADView and return it to

the "License Group" pool.  hsCADView will return to its evaluation mode after a successful seat
removal.
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Phone Removal:

Call Hachisoft Corporation at 1 877 685 0760.  Tell the operator the "License Group Code", "Site
Code", and "Machine Code".  Please note that the application will close on successful removal

and you will be required to activate a seat to use hsCADView on this computer.  A dialog will ask

you if you really want to remove the seat.  Press "Yes" to remove this seat of hsCADView.  Tell
the operator the "Removal Code" that was generated.  The operator will return it to the "License

Group" pool.  hsCADView will return to its evaluation mode after a successful seat removal.
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3.3 Trial Extension

Thanks for trying our software!   We want you to feel comfortable with our products and appreciate you
taking the time to do a thorough evaluation!   

If you need more time simply click on Request Trial Extension button on the hsCADView startup
screen. 

This will open hsCADView's New Trial Extension website in your browser. Fill in required
information on the form and click on Request Trial Extension button. This will send your request for
trial extension to our support department. You will  shortly get new Trial Extension code at your
specified email address. 
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3.4 License Agreements

 hsCADView End-User License Agreement

hsCADView utilizes the following open source libraries:

 Apache Xerces (XML processing library): Apache License Agreement

 OpenCascade (Modeling library): OpenCascade License Agreement

3.4.1 hsCADView End-User License Agreement

hsCADView End-User License Agreement

DEFINITIONS
HACHISOFT means Hachisoft Corporation, a Washington State corporation, 115 W. Astor Ave Suite 208, Colville, Washington
99114.  EULA is the End-User License Agreement between you (either an individual or a single entity) and HACHISOFT.  

SOFTWARE means all of the contents of the files, or other media provided with hsCADView, including but not limited to

HACHISOFT or third party computer information or software; related written explanatory materials or files (DOCUMENTATION);
and UPDATES (e.g. upgrades, modified versions, updates, additions), and copies of the SOFTWARE, if any, licensed to you by
HACHISOFT.  USE (or USING) means to access, install, download, copy or otherwise benefit from using the functionality of the
SOFTWARE.  ALLOWED SEATS means one (1) unless otherwise indicated under a valid volume license granted by HACHISOFT.
COMPUTER means any device capable of consuming the SOFTWARE.  

SOFTWARE LICENSE
The SOFTWARE is protected by copyright laws and international copyright treaties, as well as other intellectual property laws
and treaties. The SOFTWARE is licensed, not sold.  Its USE requires a valid license and an appropriate number of ALLOWED
SEATS.  If you do not agree to the terms of this EULA, do not install, copy, or USE the SOFTWARE.  

GRANT OF LICENSE
HACHISOFT grants you the rights described in this EULA provided that you comply with all terms and conditions of this EULA.  

1. General License Grant.  HACHISOFT grants to you a non-exclusive license to USE the SOFTWARE (i) for your
internal use; (ii) for designing, developing, testing and demonstrating your software product(s); and (iii) for
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evaluation of the SOFTWARE.  You may not reverse-engineer, decompile, or disassemble the SOFTWARE, except and
only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation.  You may
not tamper with, circumvent or otherwise prevent the license validation mechanism (if any) from operating.  You may
not rent or lease the SOFTWARE.  You may permanently transfer all of your rights under this EULA, provided you
retain no copies, you transfer all of the SOFTWARE, and the recipient agrees to the terms of this EULA. If the
SOFTWARE is an UPDATE, any transfer must include all prior versions of the SOFTWARE.

2. Documentation.  You may make and USE an unlimited number of copies of any DOCUMENTATION, provided that
such copies shall be USED only for personal internal purposes and are not to be republished or distributed.

RESERVATION OF RIGHTS AND OWNERSHIP
HACHISOFT reserves all rights not expressly granted to you in this EULA. The SOFTWARE is protected by copyright and other
intellectual property laws and treaties. HACHISOFT or its suppliers own the title, copyright, and other intellectual property rights
in the SOFTWARE. You may not rent, lease, lend, or provide commercial hosting services with the SOFTWARE.

CONSENT TO USE OF DATA 
You agree that HACHISOFT and its affiliates may collect and use technical information gathered as part of the product support
services provided to you, if any, related to the SOFTWARE.  HACHISOFT may use this information solely to improve our
products or to provide customized services or technologies to you and will not disclose this information in a form that personally
identifies you. 

COMPLIANCE WITH LICENSES 
You agree that upon request from HACHISOFT, you will within thirty (30) days fully document and certify that USE of any
HACHISOFT SOFTWARE and/or UPDATES at the time of the request is in conformity with your valid licenses from HACHISOFT,
and is supported by an appropriate number of ALLOWED SEATS.

EXPORT RESTRICTIONS
You recognize that the SOFTWARE is subject to U.S. export jurisdiction.  You agree to comply with all applicable international
and national laws that apply to the SOFTWARE, including the destination restrictions issued by the U.S. government.

TERMINATION 
Without prejudice to any other rights, HACHISOFT may terminate this EULA if you fail to comply with the terms and conditions
of this EULA. In such event, you must destroy all copies of the SOFTWARE and all of its component parts.

DISCLAIMER OF WARRANTIES
To the maximum extent permitted by applicable law, HACHISOFT and its suppliers provide the SOFTWARE, and support
services (if any) as is and with all faults, and hereby disclaim all other warranties and conditions, whether express, implied or
statutory, including, but not limited to, any (if any) implied warranties, duties or conditions of merchantability, of fitness for a
particular purpose, of reliability or availability, of accuracy or completeness of responses, of results, of workmanlike effort, of
lack of viruses, and of lack of negligence, all with regard to the SOFTWARE and the provision of or failure to provide support or
other services, information, software, and related content through the software or otherwise arising out of the USE of the
software.

EXCLUSION OF DAMAGES
To the maximum extent permitted by applicable law, in no event shall HACHISOFT or its suppliers be liable for any special,
incidental, punitive, indirect, or consequential damages whatsoever (including, but not limited to, damages for loss of profits or
confidential or other information, for business interruption, for personal injury, for loss of privacy, for failure to meet any duty
including of good faith or of reasonable care, for negligence, and for any other pecuniary or other loss whatsoever) arising out
of or in any way related to the USE of or inability to USE the SOFTWARE, the provision of or failure to provide support or other
services, information, software or otherwise arising out of the USE of the SOFTWARE, or otherwise under or in connection with
any provision of this EULA, even in the event of the fault, tort (including negligence), misrepresentation, strict liability, breach of
contract or breach of warranty of HACHISOFT or any supplier, and even if HACHISOFT or any supplier has been advised of the
possibility of such damages. 

LIMITATION OF LIABILITY AND REMEDIES
To the maximum extent permitted by applicable law the entire liability of HACHISOFT and any of its suppliers under any
provision of this EULA and your exclusive remedy hereunder shall be limited to the amount actually paid by you. The foregoing
limitations, exclusions and disclaimers shall apply, even if any remedy fails its essential purpose.

APPLICABLE LAW
This EULA is governed by the laws of the State of Washington. 

SEVERABILITY
This EULA is the entire agreement between you and HACHISOFT relating to the SOFTWARE and the support services (if any)
and they supersede all prior or oral or written communications, proposals and representations with respect to the SOFTWARE
or any other subject matter covered by this EULA. To the extent the terms of any HACHISOFT policies or programs for support
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services conflict with the terms of this EULA, the terms of this EULA shall control. If any provision of this EULA is held to be
void, invalid, unenforceable or illegal, the other provisions shall continue in full force and effect.

QUESTIONS
Should you have any questions concerning this EULA, or if you desire to contact HACHISOFT for any reason, please use the
address information enclosed in this EULA to contact HACHISOFT or visit HACHISOFT at http://www.hachisoft.com.

3.4.2 Apache License Agreement

Apache License, Version 2.0

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION 

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of this
document. 

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License. 

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under
common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause
the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more
of the outstanding shares, or (iii) beneficial ownership of such entity. 

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License. 

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code,
documentation source, and configuration files. 

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not
limited to compiled object code, generated documentation, and conversions to other media types. 

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated by
a copyright notice that is included in or attached to the work (an example is provided in the Appendix below). 

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and for
which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof. 

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or additions
to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright
owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this
definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code control systems, and issue
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but
excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution." 

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by
Licensor and subsequently incorporated within the Work. 

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative
Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object
form. 

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to
make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those
patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the
Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for that
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Work shall terminate as of the date such litigation is filed. 

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or
without modifications, and in Source or Object form, provided that You meet the following conditions: 

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and 

1. You must cause any modified files to carry prominent notices stating that You changed the files; and 

1. You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and
attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the
Derivative Works; and 

1. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must
include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do
not pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file
distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the
Derivative Works; or, within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not modify the License.
You may add Your own attribution notices within Derivative Works that You distribute, alongside or as an addendum to
the NOTICE text from the Work, provided that such additional attribution notices cannot be construed as modifying the
License. 

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and
conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided
Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License. 

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion
in the Work by You to the Licensor shall be under the terms and conditions of this License, without any additional terms or
conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement
you may have executed with Licensor regarding such Contributions. 

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product names
of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the
content of the NOTICE file. 

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either
express or implied, including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT,
MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness
of using or redistributing the Work and assume any risks associated with Your exercise of permissions under this License. 

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or
otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any
Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any
character arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages
for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even
if such Contributor has been advised of the possibility of such damages. 

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose
to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent
with this License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole responsibility,
not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any such warranty or additional
liability. 

END OF TERMS AND CONDITIONS 
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3.4.3 OpenCascade License Agreement

Open CASCADE Technology Public License
Version 6.1 March 24, 2006

Open CASCADE S.A.S. releases and makes publicly available the source code of the software Open CASCADE Technology to the
free software development community under the terms and conditions of this license.

It is not the purpose of this license to induce you to infringe any patents or other property right claims or to contest validity of
any such claims; this license has the sole purpose of protecting the integrity of the free software distribution system, which is
implemented by public license practices. Many people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he
or she is willing to distribute software through any other system and a licensee cannot impose that choice.

Please read this license carefully and completely before downloading this software. By downloading, using, modifying,
distributing and sublicensing this software, you indicate your acceptance to be bound by the terms and conditions of this
license. If you do not want to accept or cannot accept for any reasons the terms and conditions of this license, please do not
download or use in any manner this software.

1. Definitions 

Unless there is something in the subject matter or in the context inconsistent therewith, the capitalized terms used in this
License shall have the following meaning.

"Applicable Intellectual Property Rights"means (a) with respect to the Initial Developer, any rights under patents or patents
applications or other intellectual property rights that are now or hereafter acquired, owned by or assigned to the Initial
Developer and that cover subject matter contained in the Original Code, but only to the extent necessary to use, reproduce,
modify, distribute or sublicense the Original Code without infringement; and (b) with respect to You or any Contributor, any
rights under patents or patents applications or other intellectual property rights that are now or hereafter acquired, owned by
or assigned to You or to such Contributor and that cover subject matter contained in Your Modifications or in such Contributor's
Modifications, taken alone or in combination with Original Code

"Contributor" means each individual or legal entity that creates or contributes to the creation of any Modification, including the
Initial Developer. 

"Derivative Program": means a new program combining the Software or portions thereof with other source code not governed
by the terms of this License. 

"Initial Developer": means Open CASCADE S.A.S., with main offices at 1, rue Isabey 92 500 RUEIL-MALMAISON France.

"Modifications": mean any addition to, deletion from or change to the substance or the structure of the Software. When source
code of the Software is released as a series of files, a Modification is: (a) any addition to, deletion from or change to the
contents of a file containing the Software or (b) any new file or other representation of computer program statements that
contains any part of the Software. By way of example, Modifications include any debug of, or improvement to, the Original
Code or any of its components or portions as well as its next versions or releases thereof. 

"Original Code": means (a) the source code of the software Open CASCADE Technology originally made available by the Initial
Developer under this License, including the source code of any updates or upgrades of the Original Code and (b) the object
code compiled from such source code and originally made available by Initial Developer under this License. 

"Software": means the Original Code, the Modifications, the combination of Original Code and any Modifications or any
respective portions thereof. 

"You" or "Your": means an individual or a legal entity exercising rights under this License 

2. Acceptance of license

By using, reproducing, modifying, distributing or sublicensing the Software or any portion thereof, You expressly indicate Your
acceptance of the terms and conditions of this License and undertake to act in accordance with all the provisions of this License
applicable to You. 

3. Scope and purpose

This License applies to the Software and You may not use, reproduce, modify, distribute, sublicense or circulate the Software,
or any portion thereof, except as expressly provided under this License. Any attempt to otherwise use, reproduce, modify,
distribute or sublicense the Software is void and will automatically terminate Your rights under this License. 

4. Contributor license

Subject to the terms and conditions of this License, the Initial Developer and each of the Contributors hereby grant You a
world-wide, royalty-free, irrevocable and non-exclusive license under the Applicable Intellectual Property Rights they own or
control, to use, reproduce, modify, distribute and sublicense the Software provided that: 

 You reproduce in all copies of the Software the copyright and other proprietary notices and disclaimers of the Initial
Developer as they appear in the Original Code and attached hereto as Schedule "A" and any other notices or
disclaimers attached to the Software and keep intact all notices in the Original Code that refer to this License and to the
absence of any warranty; 

 You include a copy of this License with every copy of the Software You distribute; 

 If you distribute or sublicense the Software (as modified by You or on Your behalf as the case may be), You cause such
Software to be licensed as a whole, at no charge, to all third parties, under the terms and conditions of the License,
making in particular available to all third parties the source code of the Software; 

 You document all Your Modifications, indicate the date of each such Modifications, designate the version of the
Software You used, prominently include a file carrying such information with respect to the Modifications and duplicate
the copyright and other proprietary notices and disclaimers attached hereto as Schedule "B" or any other notices or
disclaimers attached to the Software with your Modifications.

For greater certainty, it is expressly understood that You may freely create Derivative Programs (without any obligation to
publish such Derivative Program) and distribute same as a single product. In such case, You must ensure that all the
requirements of this License are fulfilled for the Software or any portion thereof.

5. Your license

You hereby grant all Contributors and anyone who becomes a party under this License a world-wide, non-exclusive, royalty-free
and irrevocable license under the Applicable Intellectual Property Rights owned or controlled by You, to use, reproduce, modify,
distribute and sublicense all Your Modifications under the terms and conditions of this License. 

6. Software subject to license

Your Modifications shall be governed by the terms and conditions of this License. You are not authorized to impose any other
terms or conditions than those prevailing under this License when You distribute and/or sublicense the Software, save and
except as permitted under Section 7 hereof. 

7. Additional terms

You may choose to offer, on a non-exclusive basis, and to charge a fee for any warranty, support, maintenance, liability
obligations or other rights consistent with the scope of this License with respect to the Software (the "Additional Terms") to the
recipients of the Software. However, You may do so only on Your own behalf and on Your sole and exclusive responsibility. You
must obtain the recipient's agreement that any such Additional Terms are offered by You alone, and You hereby agree to
indemnify, defend and hold the Initial Developer and any Contributor harmless for any liability incurred by or claims asserted
against the Initial Developer or any Contributors with respect to any such Additional Terms. 

8. Disclaimer of warranty

The Software is provided under this License on an "as is" basis, without warranty of any kind, including without limitation,
warranties that the Software is free of defects, merchantable, fit for a particular purpose or non-infringing. The entire risk as to
the quality and performance of the Software is with You. 

9. Liability

Under no circumstances shall You, the Initial Developer or any Contributor be liable to any person for any direct or indirect
damages of any kind including, without limitation, damages for loss of goodwill, loss of data, work stoppage, computer failure
or malfunction or any and all other commercial damages or losses resulting from or relating to this License or indirectly to the
use of the Software. 

10. Trademark

This License does not grant any rights to use the trademarks, trade names and domain names "MATRA", "EADS Matra
Datavision", "CAS.CADE", "Open CASCADE", "opencascade.com" and "opencascade.org" or any other trademarks, trade names
or domain names used or owned by the Initial Developer. 

11. Copyright

The Initial Developer retains all rights, title and interest in and to the Original Code. You may not remove the copyright ©
notice which appears when You download the Software.

12. Term

This License is granted to You for a term equal to the remaining period of protection covered by the intellectual property rights
applicable to the Original Code.

13. Termination

In case of termination, as provided in Section 3 above, You agree to immediately stop any further use, reproduction,
modification, distribution and sublicensing of the Software and to destroy all copies of the Software that are in Your possession
or control. All sublicenses of the Software which have been properly granted prior to termination shall survive any termination
of this License. In addition, Sections 5, 8 to 11, 13.2 and 15.2 of this License, in reason of their nature, shall survive the
termination of this License for a period of fifteen (15) years. 

14. Versions of the license

The Initial Developer may publish new versions of this License from time to time. Once Original Code has been published under
a particular version of this License, You may choose to continue to use it under the terms and conditions of that version or use
the Original Code under the terms of any subsequent version of this License published by the Initial Developer.

15. Miscellaneous

15.1 Relationship of Parties

This License will not be construed as creating an agency, partnership, joint venture or any other form of legal association
between You and the Initial Developer, and You will not represent to the contrary, whether expressly, by implication or
otherwise.

15.2 Independent Development

Nothing in this License will impair the Initial Developer's right to acquire, license, develop, have others develop for it, market or
distribute technology or products that perform the same or similar functions as, or otherwise compete with, Modifications,
Derivative Programs, technology or products that You may develop, produce, market or distribute. 

15.3 Severability

If for any reason a court of competent jurisdiction finds any provision of this License, or portion thereof, to be unenforceable,
that provision of the License will be enforced to the maximum extent permissible so as to effect the economic benefits and
intent of the parties, and the remainder of this License will continue in full force and extent.

END OF THE TERMS AND CONDITIONS OF THIS LICENSE
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4 Frequently Asked Questions

If your question is not answered here? Please contact our Support.

FAQs

Q: My circle looks more like a Hexagon. What is wrong?
Answer
Just try refreshing your view with "Regen" tool. 

Q: My middle mouse doesn't work for "Pan". What is wrong?
Answer
You might have mouse software installed that allows you to configure actions on different mouse
buttons. Change Middle Button's action to "Middle Click" to be able to "Pan" using middle mouse
button. These settings are accessible in Mouse Properties of your Operating System. Mouse
Properties are located under Control Panel.

Q: Entity snap settings are not saved when i close hsCADView. Every time I start hsCADView
I have to reselect my entity snaps through Snaps Tab. Is there any way to save my entity
snaps?

Answer
The snap settings shown on Snaps Tab are only valid for current drawing. If a user wants to set

hsCADView's Entity Snaps they can be accessed from Options->Settings... Menu item. Every

time a new drawing is opened, it sets default entity snaps from hsCADView's Entity Snaps. Snap

settings changed through Options->Settings... Menu item will be saved with hsCADView and will
be activated everytime a new drawing is opened.

Q: I used Measure Area Tool to measure area of a non-planar/self intersecting polygon, but it
shows me the area as Zero or Negative value. What is correct area?

Answer
Measure Area Tool can not measure area of non-planar/self intersecting polygons correctly. The
best way to calculate correct area is to dis-integrate the required polygon into simple polygons
conceptually and then use Measure Area Tool with Continuous Mode ON to find total area of
polygons.

5 Support and Feedback

The most current support details can be found on the web at Hachisoft Support Website.

Email Support:
The primary form of support contact is via email. Our support staff can be reached at:
support@hachisoft.com

Forums:
At Hachisoft Support Website we have user forums for our products. Please use these to check for
known bugs, view upcoming update details and progress, ask questions and give feedback. 

Phone Support:
If the other support options are insufficient, then phone support is also available:

http://products.hachisoft.com/Support/tabid/70/Default.aspx
mailto:support@hachisoft.com
http://products.hachisoft.com/Support/tabid/70/Default.aspx
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1 (509) 685-0760 (Voice)
1 (866) 685-6070 (Toll Free)
1 (509) 684-1351 (Fax)

Feedback:
Your feedback is extremely important to us. We create our products for you and we are interested in
improving them. Please use one of the three methods of contact mentioned above to provide us with
feedback and suggestions.

6 Version History

Visit hsCADView online version history to view the latest hsCADView changes.

http://products.hachisoft.com/Info/Products/hsCADView/VersionHistory/tabid/156/Default.aspx
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